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Safety Precautions

 

Before starting battery tests using this application software, please thoroughly read
the 

 

PFX2000 Series Charge/Discharge Battery Test System Operation Manual

 

 that
describes the system hardware. Use extreme caution to make correct connections
and handle the components of the system properly. Improper connections or han-
dling can lead to serious accidents such as damage to or explosion of the DUT (bat-
tery).

The system is equipped with many functions for protecting the DUT (battery) both by
hardware and software. Some of the protection functions enable you to set appropri-
ate values according to the test conditions. Unless there is a special reason not to do
so, use these protection functions when performing tests.

 

Definition of Symbols

 

Indicates a potentially hazardous situation which, if
ignored, may result in damage to the product and
other property.

CAUTION



 

II  Arrangement of this manual BPC2000

 

Arrangement of this manual

 

This Manual is made up of the following sections.

 

Preface

 

Provides a brief descriptions of the product and specifies its system requirements.

 

Chapter 1 Setup

 

This chapter covers the installation of the BPChecker2000 application and the USB
driver.

 

Chapter 2 Before Using BPChecker2000

 

This chapter describes information you should know before using BPChecker2000.

 

Chapter 3 Configuring the Hardware

 

This chapter describes the Hardware Configuration Wizard that is used to configure
the PFX2000 system hardware.

 

Chapter 4 Creating Groups

 

This chapter describes the Group Administrator that is used to create groups for per-
forming tests.

 

Chapter 5 Creating Test Conditions

 

This chapter describes the Test Condition Editor and the procedure for creating test
conditions.

 

Chapter 6 Preparations for Test Execution

 

This chapter describes items that you should check and items you need to configure
before starting the actual test.

 

Chapter 7 Executing Tests

 

This chapter describes the procedures for starting the actual tests.

 

Chapter 8 Analyzing Test Results

 

This chapter describes the Graph Viewer, a tool for analyzing test results.

 

Appendix

 

The appendix provides explanation of recovery after power failures, alarms, opera-
tion when connections are improper, and folders and files that are created. It also
provides a list of the menus and the range of test condition settings.
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Preface

Outline of This Manual

This user’s manual describes BPChecker2000, an application software for the
PFX2000 Series Charge/Discharge Battery Test System.

For information regarding the hardware of the PFX2000 Series, see the PFX2000
Series Charge/Discharge Battery Test System Operation Manual.

Product Version Covered

This user’s manual covers BPChecker2000 version 2.3x.

Documents That Come with BPChecker2000

BPChecker2000 comes with the following documents.

User’s Manual
This manual. Covers all aspects of BPChecker2000 including information on how
to install the software and how to use the software.

Help Document
You can open the help document from the Help menu when BPChecker2000 is run-
ning. The help document includes all the information in this manual except the
installation procedure. It also includes some contents that are not covered in this
manual.

Start Guide
PDF documents in the tutor folder on the program CD-ROM. The guides are struc-
tured so that even first-time users can easily run the tests by using the sample test
conditions file in the same folder.

There are two guides available, one for the PFX2011 Charge/Discharge Power Sup-
ply Units (PFX 2011 tutorial.pdf) and another for the PFX2021s (PFX2021 tuto-
rial.pdf). Use the guide that corresponds to the charge/discharge power supply unit
that you are using.

Graph Viewer Operating Procedure
A PDF document named Graph Viewer.pdf in the tutor folder on the program CD-
ROM. This document explains the operating procedures of the Graph Viewer, a test
result analysis program. The Graph Viewer is also described in this manual and the
help document. However, this PDF document uses many screen images of the
Graph Viewer so that even first-time users can easily understand the procedures.

• Currently the tutorial documents are provided as in Japanese only.NOTE
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Product Overview

BPChecker2000 is a dedicated application software for the PFX2000 Series Charge/
Discharge Battery Test System. BPChecker2000 enables you to set the conditions of
the battery charge/discharge characteristics tests, execute the tests, and analyze the
test results on a personal computer (PC).

There are two editions of BPChecker2000: Full Edition and Basic Edition.

Full Edition
This edition provides you with all the functions of the BPChecker2000.

Full Edition enables you to control two systems of PFX2121 120-ch Control Units
via the USB port. This means that up to 240 charge/discharge power supply chan-
nels can be controlled simultaneously.

The 120-ch Control Unit is equipped with two TP-BUS ports, each of which can
control up to 60 charge/discharge power supply channels. For example, in the case
of the PFX2332 5-Unit Frame with five PFX2011 2-ch Charge/Discharge Power
Supply Units, up to six units can be connected to each TP-BUS port.

Furthermore, by adding a single PFX2211 Impedance Measurement Unit, imped-
ance can be measured on up to 120 charge/discharge power supply channels that are
connected to the control unit of the same system.

Moreover, if the PC is capable of GPIB or RS232C communications, temperature
chambers (by Espec Corp.) can be controlled externally for synchronized testing.

Basic Edition 
This edition provides you with limited functions of the BPChecker2000.

Basic Edition enables you to control one system of PFX2121 120-ch Control Unit
via the USB port. However, the maximum number of charge/discharge power sup-
ply channels that can be controlled is limited to 2. You cannot add the impedance
measurement unit, but synchronized temperature chamber control is equivalent to
that of the Full Edition.

Basic Edition has limitations on the maximum number of channels that can be con-
trolled and the impedance measurement function, but all other functions are equiva-
lent to the Full Edition.

Comparison of Editions

*1When using a PFX2021 Charge/Discharge Power Supply unit, the number of
controllable channels is reduced to one-half.

Full Edition Basic Edition

Number of controllable channels*1 Up to 240 channels Up to 2 channels

Ability to use the Impedance Measuring 
Unit

Possible Not possible

Synchronized operation with tempera-
ture chambers

Possible Possible

NOTE
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Program Construction

BPChecker2000 consists of the following five programs.

Hardware Configuration Wizard
This program is used to detect the charge/discharge power supply units that are con-
nected to the control unit and configure the connection environment with other
hardware devices (impedance measurement unit, temperature chamber, etc.).

Group Administrator
This program is used to create or delete groups for performing tests.

Test Condition Editor
This program is used to create and edit all test conditions related to charge/dis-
charge tests.

Test Executive
This program is used to execute charge/discharge tests according to the test condi-
tions file that you created using the Test Condition Editor.

Graph Viewer
This program is used to display graphs of the test data created by the Test Executive
on the screen and print the graphs.

System Requirements

The following are the minimum requirements for running BPChecker2000.

• Turn OFF Advanced Power Management (APM) and Suspend functions on your
PC, if they are available. If left ON, proper operation may be hindered by periodic
interrupts called SMIs to the CPU.

Personal computer

CPU Pentium III 450 MHz or faster

OS
Windows 2000 Professional (Intel) (SP2 or later) or Windows XP 
Professional (Intel)

Memory 128 MB or more

HDD
At least 20 MB of free space for installation. At least 10 GB of 
free space for storing data recommended

CD-ROM Required for installing the application

Mouse Required

Display 1024  × 768 or better

Printer Printer supported by Windows 2000 or Windows XP

NOTE
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Communications requirements

■ Communications with the control unit

■ Communications with the temperature chamber

Communication environment with the temperature chamber is required only if you
are controlling temperature chambers by Espec Corp. (up to 6 units). For the con-
nection procedure, see the respective instruction manuals.

A VISA library must be installed in the controller (Windows) for performing com-
munications with the temperature chambers.

Kikusui original VISA library (KI-VISA) is provided on the program CD-ROM.
The latest version can also be downloaded from Kikusui website (http://
www.kikusui.co.jp/en/download/).

Communicating using GPIB
You must install a GPIB driver.

Communicating using RS232C
Use a straight cable for the connection. Operation using USB-to-serial adapters is
not warranted.

RS485 protocol

USB port
Free USB ports to connect at least the number of control units to 
be used

VISA library

One of the VISA libraries below is required.
• NI-VISA 2.6 or later by National Instruments
• IO Libraries K01.00 or later by Agilent Technologies
• KI-VISA Ver. 3.0.0 or later

GPIB board
GPIB board by National Instruments or Agilent Technologies.
GPIB board by Contec or Interface can also be used when using 
KI-VISA.

GPIB driver Appropriate driver for the board

Protocol converter
PMS-CA or PMS-CG by Espec Corp.
(Control up to three temperature chambers when using RMS-CG)

RS485-to-RS232C 
adapter

ERC-200C by Espec Corp.

Address 1 to 6 Data bit 8 bits

Transmission 
mode

NORMAL Parity bit NONE

Data rate 4800 bps Delimiter CR + LF

Stop bit 2 bits
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Types of temperature chambers supported

Temperature 
chamber

Temperature chambers that can be controlled using the protocol 
converter or RS485-to-RS232C converter by Espec Corp. as indi-
cated above.
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Chapter 1 Setup

This chapter covers the installation of the BPChecker2000 application and the USB
driver.

• Installation of BPChecker2000 and USB driver requires an administrator privilege
when you log on the windows. Once installed, the application can be executed
using a user-level account.

NOTE
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1.1 Package Contents

The BPChecker2000 package contains the following items.

1.2 Installing BPChecker2000

You must install the entire program to the hard disk to use BPChecker2000. Installa-
tion is performed using a setup program (SETUP.EXE) on the CD-ROM.

1. Insert the CD-ROM into the CD-ROM drive.

2. After a few moments, Internet Explorer starts.

Select Quick Install to open the folder containing the setup program and dou-
ble-click Setup.

• If Internet Explorer does not start automatically, start Windows Explorer, click on
the CD-ROM drive, and start Setup.

The following 2 setup options are available.

 Japanese Satellite

 WinXP Visual Style

Japanese Satellite
This option is valid on PCs running Japanese Windows. If the checkbox is selected,
the Japanese version of BPChecker2000 is installed. (It is selected by default.) If the
checkbox is cleared, the English version of BPChecker2000 is installed. (On PCs
running English Windows, the English version of BPChecker2000 is installed
regardless of whether the checkbox is selected or not.)

WinXP Visual Style
This option is valid on PCs running Windows XP. If the checkbox is selected, Win-
dows XP style windows and dialog boxes are displayed by BPChecker2000.

• Due to a problem of the SETUP program, the installation may fail if not selecting
Japanese Satellite. Therefore it is highly recommended to select the Japanese Sat-
ellite option even if your PC is non-Japanese version.

The Japanese GUI will appear only when running Japanese Windows, otherwise
the English GUI will be enabled automatically.

Item Quantity

CD-ROM containing the program 1

User’s Manual (Z1-002-642) 1

NOTE

NOTE
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1.3 Installing the USB Driver

If you are connecting the PFX2121 Control Unit to the PC for the first time, you
must install the USB driver for the PFX2121. The USB driver file is included in the
BPChecker2000 CD-ROM. The installation of the driver must be carried out sepa-
rately from the installation of the application program.

Before connecting the control unit to the PC, check the rotary switch setting on the
front panel. If you are using only a single control unit, be sure to set the rotary
switch to 1. If you are using two control units simultaneously, set the rotary
switches to 1 and 2. PC will only detect the control units if the control units are set
as described above. BPChecker2000 will not operate properly if the two control
units are set to the same rotary switch setting or if the rotary switch is set to 2 when
only a single control unit is connected.

When connecting the control unit to the PC, you can connect the control unit
directly to the USB port of the PC or to a self-powered USB hub. (The control unit
cannot be connected to a bus-powered USB hub.) As the control unit is powered
from the bus, a separate power line is not necessary.

■ Installing the driver

1. Connect the PFX2121 to the USB port on the PC using a USB cable.

When the PC detects the control unit for the first time, the Plug&Play function
opens the window shown in Fig. 1-1. The same window appears, if the PC is
started with the control unit connected to the PC (assuming that the control
unit is connected for the first time).

Fig.1-1 Detection of New Hardware

After a few moments, the Found New Hardware Wizard window shown in Fig. 1-2 appears.

Fig. 1-2 Found New Hardware Wizard

2. Click Next to move to the window shown in Fig. 1-3.
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3. In Fig. 1-3, select Search for a suitable driver for my device (recom-
mended) and click Next.

Fig. 1-3 Install Hardware Device Drivers

4. On the dialog box that appears as shown in Fig. 1-4, select Specify a
location and click Next.

Fig. 1-4 Locate Driver Files

5. You will be asked to specify the location of the USB device driver file.
Specify PFX2000K.INF in the usbdrv folder on the BPChecker2000
CD-ROM and click OK.

Fig. 1-5 Specify the Location of the Driver File
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6. A message appears indicating that the wizard found the specified
driver. Click Next.

Fig. 1-6 Device Driver Detection

7. A screen appears indicating that Windows has finished installing the
device driver. Click Finish to exit the wizard.

Fig. 1-7 Finish Wizard

■ Checking whether the driver has been installed properly

To check whether the driver has been installed properly, open Device Manager to
check the status of the device.

1. Click the Start button, point to Settings, and then click Control Panel.

2. Double-click the System icon to open System Properties.

3. Click the Hardware tab and then click Device Manager.
The Device Manager window appears as shown in Fig. 1-8.

Find the Kikusui USB instruments category and check that KIKUSUI
PFX2121 is shown under it.

If two PFX2121 are connected, two KIKUSUI PFX2121 lines are shown.
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Fig. 1-8 Device Manager Display

4. Then, right-click KIKUSUI PFX2121 and choose Properties from the
shortcut menu. KIKUSUI PFX2121 Properties appear.

Fig. 1-9 PFX2121 Properties

5. Click the Device Info tab to display Instrument ID and Serial Number of
the detected PFX2121.

If you are using only a single PFX2121, confirm that Instrument ID is set to 1.
If you are using two PFX2121s, check that one of them is set to 1 and the other
is set to 2 (the order of 1 and 2 is irrelevant).
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Chapter 2 Before Using 

BPChecker2000

This chapter describes information you should know before using BPChecker2000.
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2.1 Hardware Configuration Concept on 
BPChecker2000

Concept of controllers

The concept of controllers as viewed from BPChecker2000 is the same as the actual
hardware configuration. Instrument ID refers to the number that is set using the ID
switch on the front panel of the PFX2121 120-ch Control Unit. The Instrument ID
number is either 1 or 2.

Concept of channels

The concept of channels as viewed from BPChecker2000 is simplified greatly as
compared with the actual hardware configuration. From BPChecker2000, all the
channels that are connected to a single control unit (up to 120 channels) appear as
they are connected directly. Therefore, hardware elements such as frames and units
that are in between do not exist in BPChecker2000.

Channels contain position information called node numbers. Node numbers are
automatically determined from the combination of the frame address, which is
assigned to each frame, and the node address, which is automatically determined by
the position in which the corresponding unit is installed in the frame. The frame
number is set using the FRAME switch on the rear panel of the frame. However, the
user cannot arbitrary set the node address.

The physical installation position can be determined by combining the aforemen-
tioned Instrument ID and the node number. BPChecker2000 uses these two values
to determine the channel name.

Concept of groups

Group is a concept that does not exist at the hardware level, but exists in
BPChecker2000. Basically, group is a collection of channels that share a set of test
conditions. Grouping multiple channels with the same test objective (same test con-
ditions) offer many benefits such as the simplification of operations and hierarchical
classification of test results on graphs. The assignment of temperature chamber is
also done at the group level when performing tests in synchronization with the tem-
perature chamber. (See “Concept of temperature chambers” below.)

You can create up to 64 groups. There is no limit on the number of channels that are
bound to a single group. Channels present in another controller can also be mixed
freely.

Groups are identified by their names. Unlike controllers and channels, there are no
numbers for identifying groups.

If a new group is created, the group does not contain any channels. Therefore, you
must bind at least one channel to a group. You can also unbind channels that are
already bound or delete groups that are no longer needed.
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Concept of impedance measurement unit

There are no instances in which the optional PFX2211 Impedance Measurement
Unit is implicitly handled on BPChecker2000. At the hardware level, one imped-
ance measurement unit corresponds to one controller. Therefore, all the channels
within the same controller system share a single impedance measurement unit. Con-
sequently, the impedance measurement of each channel is performed in order
according to a waiting list principle. BPChecker2000 automatically handles the
waiting list process.

Concept of temperature chambers

The synchronization of temperature chambers is assigned at the group level. Since
BPChecker2000 can create multiple groups, temperature chambers can be con-
trolled independently per group. Note that the maximum number of temperature
chambers that can be controlled is six. This means that temperature chambers can-
not be assigned to all groups (the maximum number of groups is 64).

Fig.2-1 Hardware Configuration on BPChecker2000

PC

Controller 1

Impedance measurement unit 1

Channel 001

Channel 120

Controller 2

Impedance measurement unit 2
Channel 001

Channel 120

Group 1
Temperature chamber

Reference to each channel (binding)

Group 2
Temperature chamber

Reference to each channel (binding)

*

*

* When the PFX2021 Charge/Discharge 
Power Supply Unit is used, only odd-
numbered channels are valid.
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2.2 Executable Charge/Discharge Tests

The following seven types of charge/discharge tests can be executed using
BPChecker2000.

Charge
• Constant current/constant voltage charge (CC-CV)
• Constant current charge (CC)
• Pulse charge

Discharge
• Constant current discharge (CC)
• Constant power discharge (CP)
• Constant current/pulse discharge (CC-Pulse)
• Constant power/pulse discharge (CP-Pulse) (when using the PFX2021)

These tests can be arbitrary combined to create test conditions using the Test Condi-
tion Editor and executed using the Test Executive. For details on each test, see  sec-
tion 5.4, “Seq Sheets.”

2.3 Flow of Test Procedure

If you are using BPChecker2000 for the first time after installation, carry out the
following procedure.

1. Configure the hardware (start the Hardware Configuration Wizard)

Set the number of control units and the use of impedance measurement units
and temperature chambers.

Organize the channels (charge/discharge power supply unit) separately for
each control unit system.

2. Create the group (start the Group Administrator)

Create a special folder (group) that is recognized by the BPChecker2000 sys-
tem, and specify the group folder name and path.

3. Create test conditions (start the Test Condition Editor)

Create a test conditions file.

Specify the group folder in which to save the test conditions.

4. Execute the test (start the Test Executive)

Assign the channels that were organized using the Hardware Configuration
Wizard to the groups created using the Group Administrator.

Assign the test conditions you created using the Test Condition Editor to the
channels and execute the test.

5. Analyze the test (start the Graph Viewer)

Display the test result file created by the Test Executive on graphs.
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Chapter 3 Configuring the 

Hardware

This chapter describes the Hardware Configuration Wizard that is used to configure
the PFX2000 system hardware.
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3.1 The Hardware Configuration Wizard

The Hardware Configuration Wizard is used to detect the charge/discharge power
supply units (channel modules) that are connected to the control unit and configure
the connection environment with other hardware devices (impedance measurement
unit, temperature chamber, etc.). The screen takes on a Wizard format.

Starting the Hardware Configuration Wizard

The following two methods are available in starting the program.
• From the Windows desktop folder or program folder, double-click the shortcut

icon of the Hardware Configuration Wizard program.
• Start the program from the Options menu of the Test Executive program.

The program that starts using either of the two methods is the same, but the opera-
tion of the program varies depending on the execution status of the Test Executive.

When the Test Executive is running
All the setup items on the Hardware Configuration Wizard are set to read-only, and
settings cannot be changed.

When you exit the Test Executive, the settings can be changed.

When the Test Executive is not running
All the setup items on the Hardware Configuration Wizard can be changed.

However, do not start the Test Executive until you close the Hardware Configuration
Wizard.
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3.2 Configuring the Hardware

The Hardware Configuration Wizard consists of the following three steps (screens).

If you click the Cancel button in the middle of the operation, the settings on that
page may be discarded.

Step 1 Controller configuration

Step 2 Channel configuration

Step 3 Temperature chamber configuration

1. Start the Hardware Configuration Wizard.

The controller configuration screen appears.

If the Test Executive is running, close it to allow changes in the Hardware Con-
figuration Wizard settings.

Fig.3-1 Step 1/3

On this screen, specify the number of controller units and impedance measurement
units that is to be used.
• Num of Controller

Select 1 or 2 depending on the number of control units to be used.

On the Basic Edition, only 1 control unit can be used.
• Impedance unit #1 (#2)

Specify whether to use the impedance measurement unit for each control unit.

On the Basic Edition, the impedance measurement unit cannot be used.
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2. When you are done with the settings, click Next.
The channel configuration screen appears.

Fig. 3-2 Step 2/3  Channels Not Yet Configured

On this screen, set the number of channel modules (charge/discharge power
supply units) to be used for each controller unit. The list shows all the channels
that are currently detected.

The maximum number of channels that can be used on the Basic Edition is 2.

When configuring new channels
When configuring a new channel such as when you are using the BPC2000
system for the first time, select the controller system from Configuration on
and click Reorganise.

Channels that are connected to the selected controller are displayed. When
using 2 controller systems, configure the channels for each.

• When reorganize is carried out, all the data including the current channel
configuration, group and channel assignments, and the progress status of
the test are lost. Use extra caution when performing this procedure.
To simply add or delete channels, use the Add or Delete buttons. In this
case, the existing configuration information is retained.

CAUTION
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When adding or deleting channels from an existing channel configura-
tion
To add a channel to the existing channel configuration, click Add. The Add Channel
dialog box appears. Enter the node number of the channel module to be added and
click Add.

Fig. 3-3 Addition of Channels

To delete channels from the existing channel configuration, select the channels you
wish to delete, and click Delete.

Fig. 3-4 Step 2/3  Channels Configured

The channel names that appear on the list take the following form.

CH_1_001

Node number
Instrument ID
Header
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3. When you are done with the settings, click Next.
The temperature chamber configuration screen appears. For details on syn-
chronized operation of temperature chambers, see section 7.10, “Temperature
Chamber Synchronization.”

Fig. 3-5 Step 3/3

On this screen, enter settings for using the temperature chamber.
• Num of Chambers

Set the number of temperature chambers. You can specify up to 6 chambers. A
value of 0 means that the temperature chamber is not used. VISA library soft-
ware is required to use the temperature chambers. For details on the VISA
library, see “Communications with the temperature chamber” on page P-4 .

• Chamber Driver

Select the driver software for the temperature chamber. Currently, only Tabai is
supported.

• VISA Resource

To use GPIB, specify the GPIB board number and GPIB address name.

Example) If the GPIB board number is 0 and the GPIB address is 1

Select GPIB0::1::INSTR.

To use RS232C, specify the COM number of the serial port.

Example) For serial port COM1

Select ASRL1::INSTR.
• Control Humidity

If this checkbox is selected, humidity control is performed. If it is not, only
temperature control is performed.

• Temperature Margin and Humidity Margin

Set the margins for the temperature and humidity settings.

4. Click Finish to exit the Hardware Configuration Wizard.

If you are not using the temperature chamber,
select 0 and proceed to step 4.
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Chapter 4 Creating Groups

This chapter describes the Group Administrator that is used to create groups for per-
forming tests.
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4.1 The Group Administrator

The Group Administrator is used to create groups for performing tests.

Groups are used to handle multiple test execution channels collectively. All files
including test conditions and test results are created within a specific group folder.
Channels existing in the same group can share the test conditions created within the
group. In addition, when performing tests in synchronization with the temperature
chambers, they are done at the group level.

Starting the Group Administrator

To start the Group Administrator, double-click the shortcut icon of the Group
Administrator program from the Windows desktop folder or program folder.

You can also start the program from the Group menu of the Test Executive program.

4.2 Adding and Deleting Groups

When the Group Administrator is stared, a list of all current registered groups is
shown on the screen.

To create a group, you must decide on the group name and folder name for saving
the data files (test conditions, measurement data, etc.) in advance. (It is recom-
mended that the same name be used for the group name and folder name.)

Fig.4-1 Registered Group
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■ Adding a group

1. Click Add.

Add Group dialog box appears.

Fig. 4-2

2. Click the [...] button to the right of the folder path box.

The Browse For Folder dialog box appears.

Fig. 4-3

3. Specify the data folder that the group is to use.

For the data folder, you can use an existing folder or create a new folder in the
Browse For Folder dialog box.

If the group name or the folder is already in use by an existing group, the new
group cannot be created.

When you specify the data folder and return to the Add Group dialog box, the
folder path is displayed. By default, the folder name is entered in the Name
box.

Fig. 4-4
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4. If you do not need to change the group name, click OK to close the dia-
log box.

If you wish to use a different group name, enter the group name in the Name
box, and then click OK to close the dialog box.

When group creation is complete, the group is registered and managed as a
BPChecker2000 system group. From this point, it is identified by the Test Executive
program.

In addition, the folder is given a special icon. The icon is used also when the folder
is displayed on Windows Explorer. (A Desktop.INI file is created in the group folder
to display the special icon. Do not delete this file.)

If an existing folder is specified as the folder for the group, the existing folders and
files inside the specified folder are not deleted or changed (however, Desktop.INI is
created).

Fig. 4-5

■ Deleting a group

If you wish to delete an existing group, select the group and click Delete.

However, groups that have one or more channels bounded to them cannot be
deleted.

When group deletion is complete, the registration of the group is removed from the
group management of the BPChecker2000 system, and the special icon is no longer
displayed. The folder and existing folders and files inside the folder are not deleted
or changed (however, Desktop.INI is deleted).

Special icon

Desktop.INI file
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Chapter 5 Creating Test 

Conditions

This chapter describes the Test Condition Editor and the procedure for creating test
conditions.
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5.1 Test Condition Editor

The Test Condition Editor is a program used to create and edit all test conditions
related to charge/discharge tests.

The contents that are edited using the Test Condition Editor include several items
other than those that actually concern the test conditions. The editable contents are
grouped into the following categories.

1. Module

2. Comment

3. Battery information

4. Protections

5. Recording Method

6. Impedance Measurement

7. Life Judgement

8. Sequence

9. Sequence sheets

You can assign an arbitrary name to the test conditions file and place the file in an
arbitrary folder.

Starting the Test Condition Editor

To start the Test Condition Editor, double-click the shortcut icon of the Test Condi-
tion Editor program from the Windows desktop folder or program folder.

You can also start the program from the Group menu of the Test Executive program.

Fig.5-1 Test Conditions > Initial Screen

The left and right sides of the screen are called Item Pane and Form Pane, respec-
tively.

Item pane Form pane
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5.2 Creating and Saving Test Conditions Files

■ Creating a test conditions file

Creating a new file
To create a new test conditions file, choose New from the File menu. The condition
of the program when it is started is the same as when the Test Condition Editor is
first started from the shortcut icon. The test conditions file name is shown as Unti-
tled.

Changing an existing file
To change an existing test conditions file, choose Open from the File menu.

If you save the modified file to a separate file by selecting Save As from the File
menu, a new file diverted from the existing file can be created.

■ Saving the test conditions file

To save the opened test conditions file, choose Save from the File menu.

To save to a separate name, choose Save As from the File menu, and specify the
destination file name in the file dialog box. When saving the file by assigning a
name, the Test Condition Editor sometimes displays a message concerning group
management.

Message that appears when saving a file

Fig. 5-2 Message That Appears When Saving a File

When the Test Executive program uses a test conditions file to execute the test, the
test conditions file must reside immediately under the folder of a group that the
BPChecker2000 system identifies.

For example, if a test conditions file named C:\MyFolder\MyTestCond.BPCT is
created and the file is to be used in an actual test, the folder named C:\MyFolder
must be a group folder that the BPChecker2000 system identifies. If the folder is not
yet identified, the test conditions file can be saved, but the Test Executive cannot use
it.

When a test conditions file is saved, the Test Condition Editor always checks
whether the folder that will contain the test conditions file belongs to a group that
the BPChecker2000 system identifies. If it is not, the Test Condition Editor will ask
whether the folder is to be registered and identified as a group. If you decide to reg-
ister, the Add Group dialog box appears.
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Fig. 5-3 Add Group Dialog Box

This dialog box is basically the same as the dialog box that the Group Administrator
displays, except the folder path name is already determined and cannot be changed.

In addition, the group name that is indicated is a recommended name that has
already been confirmed as a new assignable group name. Unless there is a special
reason not to do so, create the group using this name.

If the folder is identified as a group here, the Test Executive will interpret the file as
a test conditions file that can be used for executing the test.
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5.3 Test Condition Items

The Test Condition Editor takes on a window layout similar to Windows Explorer.
Selecting an item on the left side of the screen (Item Pane) switches the right side of
the screen (Form Pane). The contents of the Form Pane vary depending on the
selected item.

The succeeding sections will describe the contents of each item in order.

• Showing the input range
For items that require a value to be entered in a text box such as the nominal volt-
age of Fig. 5-4, the input range appears when you move the mouse pointer over
the text box.

Fig. 5-4 Showing the input range

The example of Fig. 5-4 indicates that the nominal voltage can be entered in the
range of 0.0000 V to 5.0000 V.

You can enter a value outside the indicated range, but when you select an item
from a different item pane (move to different screen), a message illustrated in Fig.
5-5 will appear.

Fig. 5-5 Message Indicating That the Value Is Outside the Range

• The input ranges are listed in appendix section A.5, “Range of Test Condition Set-
tings.”

NOTE
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5.3.1 Module

This screen displays information about the charge/discharge power supply unit to be
used. The screen is used to enter basic settings.

Fig. 5-6 Test Condition > Module Screen

Expected Model
Set the model (Model ID) of the power supply module you plan to use. This allows
appropriate input ranges of parameters such as voltage and current to be speculated.
The appropriate input ranges that are determined by the model selection are also
used to check the range of values entered for other items that specify the actual
charge/discharge conditions. 

Normally, the selectable models are as follows:

The list shown below the drop-down list contains an outline of the electrical specifi-
cations of the selected charge/discharge power supply unit.

If you select PFX2011, the values for high and low current ranges are displayed.
You can select different ranges for the high and low ranges for each cycle or for
charge and discharge even within the same cycle.

If you select PFX2021, values are shown only in the high range column, because
there is only one current range.

Use This Model ID As Default
Press this button to make the model selected for Expected Model the default model.
The condition of this default model is applied to the new test conditions that are cre-
ated.

Model ID Model

1 PFX2011

21 PFX2021
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• On some special-order specifications of the BPChecker2000 systems, you may be
able to select Model IDs that are not usually selectable.
When assigning test conditions to actually execute the test, the Model ID selected
here and the actual model ID of the module (power supply module that is actually
used in the charge/discharge test) must match, or the test cannot be executed.
When multiple Model IDs are supported, select the Model ID here carefully.

Enable AutoFine
The auto fine (auto correction) function is enabled if the checkbox is selected.

The auto fine function brings the current value set by the constant current operation
and the current that actually flows closer together through automatic adjustment.
You can eliminate the error caused by the accuracy of the constant current setting by
enabling this function. This function is effective when you need higher accuracy of
constant current performance or when you wish to suppress the current error
between channels.

Enable DUT Connection Check
The connection check function of the DUT (device under test) is enabled if the
checkbox is selected.

The DUT connection check function generates a warning when you attempt to exe-
cute the test when the DUT is not connected.

Moving Average
Select the moving average value.

You can decrease the fluctuation of the measured value even further by performing
moving average. You can select the average count from n = 0 (OFF), 2, 4, and 8.

NOTE
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5.3.2 Comments

This screen is used to enter the date, the name of the operator, and notes.

Fig. 5-7 Test Condition > Comments Screen

Date
Enter the date directly or click the arrow on the right and use the date picker (calen-
dar screen used to enter the date) that appears.

Operator
Enter the name of the operator.You can enter up to 63 characters.

Notes
Enter an arbitrary note or comment.You can enter up to 255 characters.

Input format
dd/mm/yyyy or some similar format 
(The actual input format of the date 
depends on the Windows region setting.)
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5.3.3 Battery Info

This screen is used to enter information concerning the battery.

Fig. 5-8 Test Condition > Battery Info

Sample Name
Enter the name of the DUT (battery).

Nominal Voltage
Enter the nominal voltage of the DUT.

Nominal Capacity
Enter the nominal capacity of the DUT. The nominal capacity is used as a reference
when setting OAH (overcharge capacity protection). Enter an appropriate value.

Volume
Enter the volume of the DUT.

Weight
Enter the weight of the DUT.
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5.3.4 Protections

• This function is used to prevent serious accidents such as damages to or
explosion of the DUT (battery). Unless there is a special reason not to do
so, use this protection function when performing tests.

• You must set software protection to protect the DUT (battery). However, if you do
not set appropriate values, alarms and warnings will occur frequently, and you
will not be able to execute the tests.

For a detailed explanation of alarms and warnings, see the appendix.

This screen is used to set the software protection. For a description of how to set the
hardware protection, see “Protections page” in section 7.12.4, “Properties Display.”

Each item is enabled only when the checkbox is selected. Items that have their
checkboxes cleared do not function.

Fig. 5-9 Test Condition > Protections

OVP
Enter the software OVP (overvoltage protection) value. If battery voltage exceeds
the OVP value during testing, an alarm occurs and the test is aborted.

UVP
Enter the software UVP (undervoltage protection) value. If battery voltage falls
below the UVP value during testing, an alarm occurs and the test is aborted.
In normal cases, set a voltage relatively close to the cutoff voltage for discharging.

CAUTION

NOTE
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OAH
Enter the software OAH (overcharge capacity protection) value. If battery capacity
exceeds the OAH value during charge testing, an alarm occurs and the test is
aborted. The value is a percentage with respect to the nominal capacity [mAh] that
was entered in section 5.3.3, “Battery Info.”
Set an appropriate value when performing overcharge or overdischarge tests.

OTP
Enter the software OTP (overtemperature protection) value. If battery temperature
exceeds the OTP value during testing, an alarm occurs and the test is aborted.
Specify an appropriate value by taking the temperature measurement error and
ambient temperature fluctuation into consideration.

OCP (Automatic)
The software OCP (overcurrent protection) value is equal to the specified current +
100 mA (10 mA when set to low range). If charge current exceeds the OCP value
during testing, an alarm occurs and the test is aborted.
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5.3.5 Recording Method

This screen is used to set the recording method of the charge/discharge data file that
the Test Executive creates. You can select one or more items.

Each item is enabled only when the checkbox is selected. Items that have their
checkboxes cleared do not function.

• Note that charge/discharge data will not be recorded, if all items are not selected.

Fig. 5-10 Test Condition > Recording Method

Delta Time [s]
Data is recorded at the specified time interval. If a short time is specified, the
amount of data that is recorded increases. Note that if the test period is long (several
hours or more), the number of data points becomes greater than 1 000 points. There-
fore, use caution when setting the time.

When the test period is long, consider using “AutoDelta Time” that puts a limitation based
on the total amount of data. If AutoDelta Time is selected, this item cannot be selected.

Auto Delta Time
Calculates a different delta time for each test phase and uses the calculated time
interval to record the data. The delta time is calculated by dividing the maximum
test period of each phase (the time when the test is performed as scheduled without
early termination including the pause section) by the “maximum number of data
points.” Specify the maximum number of data points here.

If Delta Time is selected, this item cannot be selected.

Delta Voltage [V]
Data is recorded when the voltage changes by an amount greater than the specified value.

Delta Current [A]
Data is recorded when the current changes by an amount greater than the specified value.

NOTE
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5.3.6 Impedance Measurement

This screen is used to set the impedance measurement.

Fig. 5-11 Test Condition > Impedance Measurement

Frequency [Hz]
Set the measurement frequency. The frequency is fixed to 1000 Hz in the current
version of the software.

Range [Ω]
Select the measurement range.

Auto Range
The auto range function is enabled if the checkbox is selected. Using the selected
measurement range as the starting point, this function automatically switches the
range as necessary.

Measure Immediately After
Specify the point in the test execution cycle when impedance measurement is to be
carried out. You can turn ON/OFF the selection independently. Measurement is per-
formed only at the point corresponding to the selected checkboxes.

Charge Measures immediately after charge is complete.

Charge Rest Measures immediately after charge rest is complete.

Discharge Measures immediately after discharge is complete.

Discharge Rest Measures immediately after discharge rest is complete.
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5.3.7 Life Judgement

This screen is used to set the life judgement items. Battery capacity generally
degrades or its impedance increases as batteries are repeatedly charged and dis-
charged. The life judgement function determines the performance degradation of
the battery by comparing the actual capacity against the nominal capacity and mea-
suring the impedance value. This function terminates the test in the same manner as
when the test is normally completed if it determines that the battery has reached the
end of its life. For details on the termination of the test, see section 7.4, “Terminat-
ing Tests."

Fig. 5-12 Test Condition > Life Judgement

Do Capacity Rate Judgement
If this checkbox is selected, the function determines that the battery has reached the
end of its life when the measured capacity falls below the specified percentage
(minimum capacity rate value) of the nominal capacity.

• Min Capacity Rate [%]
The minimum capacity rate can only be specified for discharge. The reference
capacity value is the nominal capacity [mAh] that was entered in section 5.3.3,
“Battery Info,” which is taken to be 100%.

Do Impedance Judgement
If this checkbox is selected, the function determines that the battery has reached the
end of its life when the measured impedance exceeds the specified impedance.

• Max Impedance [mohm]
The maximum impedance can be specified independently for charge and dis-
charge. The maximum impedance is evaluated on all measurements that were
specified in section 5.3.6, “Impedance Measurement.”
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Max NG Count
Specify the number of failures for terminating the test. For example, if you specify a
value of 9, the test is terminated when the function determines that the battery has
reached the end of its life nine times.

5.3.8 Sequence

This screen is used to set the sequence. Sequence defines how to execute the charge/
discharge contents that are specified in sequence sheets #1 to #15 (described in sec-
tion 5.4, “Seq Sheets”). The Test Executive performs the charge/discharge test
according to the sequence information specified here.

Repeat specifies the number of times a sequence sheet is repeated; Loop specifies
the number of times the set of sequence sheets (all 15 types) are repeated. The test is
performed in order from sequence sheet #1.

Fig. 5-13 Test Condition > Sequence

Common Sequence Template

The “Common Sequence Template” is a function that is necessary only when con-
trolling temperature chambers.

BPChecker2000 is designed to accommodate the case in which the temperature
chamber synchronization is used.

For details, see section 7.10.3, “Common Sequence Templete."
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If the Common Sequence Template function is on
Set the name of the "common sequence template" that is shared among multiple test
conditions files.

If the Common Sequence Template function is off
A separate .si file is not generated. All of the information are saved to the .bpct file.

Test sequence

The test is executed according to the sequence specified here. 15 types (#1 to #15)
of test sheets of charge and discharge can be specified. You can repeat any of these
sheets the necessary number of times and loop the entire sequence the necessary
number of times. In addition, by using the sheet dedicated to predischarge (also
referred to as sheet #0), you can perform predischarge.

Repeat
Set the number of times to execute the corresponding sequence sheet. If you specify
0, the sequence sheet is skipped.

Record
Specify whether to record the C/D data (charge/discharge data) at the test cycle
when the corresponding sequence sheet is enabled. Record (data file) remains only
if the checkbox is selected. However, since the last cycle when the entire test is fin-
ished or aborted must be saved, C/D data file is created once even if Record is dis-
abled. The file is automatically deleted when the relevant cycle is no longer the last
cycle (when the data for the next cycle is created).

Loop
Set the number of times to repeat the test consisting of sequence sheets #1 to #15.

Perform Startup Discharges
Select whether to execute startup predischarge. Startup predischarge refers to dis-
charge that is carried out before the execution of the first cycle when a new test is
started or when the test is aborted and restarted.

If enabled, you must specify the details of the startup predischarge that is to be exe-
cuted. 

If you select the Use Predischarge Sheet checkbox, a special predischarge
sequence sheet (sequence sheet #0) is used, not the discharge sheet of sequence
sheets #1 to #15. 

If you select the Use Discharge Sheet of Previous Cycle, the discharge sheet of the
sequence sheet that corresponds to the cycle previous to the restart cycle is used. 

However, if the Do Predischarge when the sheet is first used setting that is present
in each charge sheet of sequence sheets #1 to #15 and the execution condition of
predischarge conflict with each other, the setting of each sheet is prioritized. If pre-
discharge is executed according to the setting of each sheet, sequence sheet #0 is
used.
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Relationship between the predischarge settings and discharge sheets
that are executed
The relationship of these settings is explained using Table 5-1 shows how predis-
charge is executed depending on the predischarge settings when a simple sequence
is created using only sequence sheets #1 and #2. There are twelve patterns in the
predischarge setup pattern that you can set by using two sequence sheets (the top
block in Table 5-1.)

Table5-1 Examples of Predischarge Settings and Discharge 
Sheets That Are Executed

1 2 3 4 5 6 7 8 9 10 11 12 Predischarge setup pattern

Execute startup discharges

✓ ✓ ✓ ✓ Use Predischarge Sheet

✓ ✓ ✓ ✓ Use Discharge Sheet of Previous Cycle

Do Predischarge when the sheet is first used

✓ ✓ ✓ ✓ ✓ ✓ Sequence sheet #1

✓ ✓ ✓ ✓ ✓ ✓ Sequence sheet #2

Test start Case 1

Predischarge - #0 - #0 #0 #0 #0 #0 #0 #0 #0 #0 Sequence setting
Sheet #1 Repeat: 2
Sheet #2 Repeat: 1
Sheets #3 to #15 Repeat: 0
Loop: 2

The value #0 in the predischarge row 
indicates that the predischarge sheet is 
used.

Cycle 1 Sequence sheet #1

Cycle 2 Sequence sheet #1

Predischarge - - #0 #0 - - #0 #0 - - #0 #0

Cycle 3 Sequence sheet #2

Cycle 4 Sequence sheet #1

Cycle 5 Sequence sheet #1

Cycle 6 Sequence sheet #2

Test start Case 2

Predischarge - #0 - #0 #0 #0 #0 #0 #0 #0 #0 #0 Sequence setting
Sheet #1 Repeat: 2
Sheet #2 Repeat: 1
Sheets #3 to #15 Repeat: 0
Loop: 2

Abort the test at cycle 3 and restart.

The values #0, #1, and #2 in the predis-
charge row indicate that the predis-
charge sheet, the discharge sheet of 
sheet #1, and the discharge sheet of 
sheet #2 are used, respectively.

Cycle 1 Sequence sheet #1

Cycle 2 Sequence sheet #1

Predischarge - - #0 #0 - - #0 #0 - - #0 #0

Cycle 3 Sequence sheet #2Abort

Test restart

Predischarge - - #0 #0 #0 #0 #0 #0 #1 #1 #0 #0

Cycle 3 Sequence sheet #2

Cycle 4 Sequence sheet #1

Cycle 5 Sequence sheet #1

Cycle 6 Sequence sheet #2
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• Case 1
Case 1 (the middle block in Table 5-1) is the case when the specified sequence fin-
ished normally. 

The predischarge setup patterns 1 to 5 and 7 are executed simply as they are speci-
fied. 

For patterns 6 and 8, there is a conflict in the predischarge settings immediately
after the test is started between the sequence sheet setting and the sheet #1 setting.
In this case, the setting of each sheet has priority, and predischarge is never executed
twice. 

For patterns 9 to 12, Use Discharge Sheet of Previous Cycle is selected. Since star-
tup predischarge is executed only immediately after the test is started (there is no
previous cycle) in Case 1, the result is the same as when Use Predischarge Sheet is
selected.

• Case 2
Case 2 (the bottom block in Table 5-1) is the case when the test is aborted at cycle 3
of the specified sequence and then restarted. Since a test is restarted from the
aborted cycle, the test in Case 2 is restarted from cycle 3. 

The sequence sheet that is used first when the test is restarted is the sheet that was
being used when the test was aborted. However, the trace that the sheet was used is
lost when the test is aborted. 

In Case 2, sequence sheet #2 is used when the test is restarted, but in this case,
sequence sheet #2 is considered to be used for the first time. In other words, if the
Do Predischarge when the sheet is first used checkbox of sequence sheet #2 is
selected, the predischarge sheet is reused as shown in predischarge setup patterns 3,
4, 7, 8, 11, and 12. 

Use Predischarge Sheet is selected in patterns 5 and 6. Thus, predischarge is exe-
cuted when the test is restarted. 

Use Discharge Sheet of Previous Cycle is selected in patterns 9 and 10. Thus, pre-
discharge is executed using sequence sheet #1 when the test is restarted.

Set Chamber When Finished/Aborted

This setting is enabled when the test is executed using the temperature chamber syn-
chronization.

If the checkbox is selected, the temperature and humidity of the temperature cham-
ber specified on the sequence sheet can be reset to the values specified here when
the test is finished or aborted.

When setting the humidity, check the control range of the temperature and humidity
of the temperature chamber being used. Depending on the performance of the tem-
perature chamber, some humidity ranges may not be possible against the specified
temperature. In such case, specify -1 and the humidity control will be disabled.

For details on synchronized operation of temperature chambers, see section 7.10,
“Temperature Chamber Synchronization."
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5.4 Seq Sheets

Sequence sheets include the predischarge sheet and sheets #1 to #15. Since each
sheet from #1 to #15 consists of a charge condition sheet and a discharge condition
sheet, the total number of sheets is 31.

This section describes the sequence sheets in the following order.

1. Items common to charge condition sheets

2. Items of CC-CV charge mode

3. Items of CC charge mode

4. Items of Pulse charge mode

5. Items common to the predischarge sheet and discharge condition sheets

6. Items of CC discharge mode

7. Items of CP discharge mode

8. Items of CC-Pulse discharge mode

9. Items of CP-Pulse discharge mode

5.4.1 Charge Conditions (Sequence Sheets #1 to #15)

Here, the type of charge test to be executed is specifically defined. Since the items
that need to be specified vary greatly depending on the operation mode, description
will be given independently for each operation mode. However, range selection,
mode selection, temperature chamber setup conditions, and predischarge setup
function are common to all modes.

Fig. 5-14 Test Condition > Sequence Sheets
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Items independent of the mode setting

Range
You can select the range if you selected the PFX2011 Charge/Discharge Power Sup-
ply Unit for “Expected Model” in section 5.3.1, “Module.”

Depending on the range selection, the valid ranges for settings concerning current,
capacity, and power vary.

Mode
Select the charge mode. Select CC-CV, CC, or Pulse.

• Other modes may be included depending on the Test Condition Editor version.
However, they are for special-order features. Dimmed items are not selectable.

Enable Chamber Control
If this item is enabled, temperature chamber settings are performed in the cycle if
this sequence sheet is used. In this case, you must also enter Temperature [°C],
Humidity [%], Setting Timeout [min], and Wait Time [min].

Temperature [°C]
Specify the temperature setting of the chamber.

Humidity [%]
Specify the humidity setting of the chamber.

Check the control range of the temperature and humidity of the temperature cham-
ber being used. Depending on the performance of the temperature chamber, some
humidity ranges may not be possible against the specified temperature. In such case,
specify -1 and the humidity control will be disabled.

Setting Timeout [min]
The temperature chamber does not reach the specified condition immediately after
the temperature and humidity are set. If the temperature chamber does not reach the
target temperature and humidity (within the range specified in system settings) even
after the specified time elapses, the setting is considered to have failed.

Wait Time [min]
Even if the temperature chamber reaches the target temperature and humidity, you
must allow some time for the battery in the chamber to reach the temperature. This
setting specifies the wait time. If testing is performed in synchronization with the
temperature chambers, the actual charge starts after the wait time elapses.

For details on synchronized operation of temperature chambers, see section 7.10,
“Temperature Chamber Synchronization."

Do Predischarge when the sheet is first used
If this item is enabled, predischarge is executed once when this sequence sheet is
used first. Predischarge sequence sheet (sequence sheet #0) is used for the predis-
charge.

This setting has priority if the Execute startup discharges setting that is specified on
the sequence page and the execution condition of predischarge conflict with each
other. For more details, see “Execute startup discharges” in section 5.3.8, “Sequence.”

NOTE
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5.4.2 CC-CV Charge

Fig. 5-15 shows an illustration of the constant current/constant voltage charge (CC-
CV) operation. The figure illustrates the transition of constant current charge →
constant voltage charge → CV time → charge rest. (In this example, charge is com-
plete when CV time is reached.)

Fig. 5-15 Illustration of Constant Current/Constant Voltage Charge

Fig. 5-16 Test Condition > Sequence Sheet (CC-CV Charge)

Charge Time [h:min]
Indicates the maximum time for a charge period. Charge Time is one of the function
that terminate charging. Charging stops after this time elapses, if it has not already
been ended by another factor. If the entry is 0:00, charge is skipped.

Charge time

CV time

Battery voltage
CV voltage

Charge current Rest time
It time

It current
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Rest Time [h:min]
Indicates the state in which nothing is performed after charging is finished and
before transiting to discharging. If the entry is 0:00, rest is skipped.

Current [A]
Indicates the charge current. The input range varies depending on the range setting on
the PFX2011 Charge/Discharge Power Supply Unit.

CV Voltage [V]
CV voltage indicates the voltage value at which the battery voltage moves to con-
stant voltage (CV) operation.

CV Time [h:min]
CV time is one of the factors that terminate charging. Charging ends when this CV
time elapses after constant voltage (CV) operation has started.

Enable It Functionality
Selecting this checkbox enables you to set It Current and It Time.

It Current [A]
It current is the current value for detecting charge current, which may be arbitrarily set by
the user when performing a constant voltage charge. After this current is detected, charging
ends once the set It time elapses. 

Enter the It current value. Enter the current value to be detected during current voltage
(CV) operation.

The input range varies depending on the range setting on the PFX2011 Charge/Discharge
Power Supply Unit.

It Time [h:min]
It time is one of the factors that terminate charging. Charging ends when this It time
elapses after detecting It current.

Max Temp [°C]
Maximum temperature is one of the factors that terminate charging. Charging ends
when the battery temperature exceeds the specified value during charging.
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5.4.3 CC Charge

Fig. 5-17 shows an illustration of the constant current charge (CC) operation. The
figure illustrates the transition of constant current charge → -dV detection → charge
termination → charge rest.

Fig. 5-17 Illustration of Constant Current Charge

Fig. 5-18 Test Condition > Sequence Sheet (CC Charge)

Charge Time [h:min]
Indicates the maximum time for a charge period. Charge Time is one of the function
that terminate charging. Charging stops after this time elapses, if it has not already
been ended by another factor. If the entry is 0:00, charge is skipped.

Rest Time [h:min]
Indicates the state in which nothing is performed after charging is finished and
before transiting to discharging. If the entry is 0:00, rest is skipped.

Current [A]
Indicates the charge current. The input range varies depending on the range setting on
the PFX2011 Charge/Discharge Power Supply Unit.

  -dV

Charge time

Maximum voltage
Battery voltage

Charge current
Rest time
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Max Voltage [V]
Maximum voltage is one of the factors that terminate charging. Charging ends when
the battery voltage reaches the specified value during charging.

Enable Delta-V Functionality
Select this checkbox enables you to set -dV and -dV Mask Time.

-dV [V]
The value -dV is one of the factors that terminate charging. Charging ends when the
battery voltage drops by a value specified by -dV during charging. This detection
can be disabled during the -dV mask time.

-dV Mask Time [min]
Enter the -dV mask time. The -dV detection is disabled during this period.

Enable Temperature Functionality
Selecting this checkbox enables you to set Max Temp and dT/dt.

Max Temp [°C]
Maximum temperature is one of the factors that terminate charging. Charging ends
when the battery temperature exceeds the specified value during charging.

dT/dt
The value dT/dt is one of the factors that terminate charging. Charging ends when
the battery temperature increases by dT/dt within a unit time (1 minute) during
charging.
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5.4.4 Pulse Charge

Fig. 5-19 shows an illustration of the pulse charge operation. In pulse charge, charg-
ing is performed over three periods: constant current charge (CC), constant current/
pulse charge (CC-Pulse), and PWM pulse charge (PWM).

Fig. 5-19 illustrates the transition of constant current charge  → maximum (transi-
tion) voltage detection → constant current/pulse charge  → maximum (transition)
voltage  → Pulse ON current  → Pulse OFF current  → minimum voltage detection
→ It time  → charge rest.

(when the period from pulse OFF to minimum voltage detection is
less than or equal to It time)

Fig. 5-19 Illustration of Pulse Charge

Fig. 5-20 Test Condition > Sequence Sheet (Pulse Charge)

Charge time

PWM time

Battery
voltage Maximum

voltage

Maximum
voltage

ON timePulse time 1

Pulse time 2 It time

Charge
current Constant

current
Pulse current 1 Pulse current 2 Pulse ON current Pulse OFF current Rest time

CC period [1] CC-Pulse period [2] PWM period [3]

Minimum voltage Maximum voltage
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CC Period [1]

• Max Voltage [V]
When the battery voltage reaches this voltage during CC charging, the opera-
tion moves to the CC-Pulse period.

• Current [A]
Indicates the charge current during the CC period.

The input range varies depending on the range setting on the PFX2011 Charge/
Discharge Power Supply Unit.

CC-Pulse Period [2]

• Max Voltage [V]
When the battery voltage reaches this voltage during CC-Pulse charging, the
operation moves to the PWM period.

• Current [A] (1 and 2)
Indicates the pulse current (1 and 2) during the CC-Pulse period.

The input range varies depending on the range setting on the PFX2011 Charge/
Discharge Power Supply Unit.

• Time [ms] (1 and 2)
Indicates the pulse time width (1 and 2) during the CC-Pulse period.

PWM Period [3]

• Max Time [h:min]
Indicates the maximum time for the PWM period. When this time elapses, the
operation moves to charge rest.

• Min Voltage [V]
When the battery voltages drops to this voltage during pulse OFF current, the
operation moves to pulse ON current.

• Max Voltage [V]
When the battery voltages reaches this voltage during pulse ON current, the
operation moves to pulse OFF current.

Selecting the check box enables you to set the maximum voltage. Current con-
trol during the PWM period varies depending on the selected/unselected status
of this check box. For details, see “Current control during the PWM period” on
Page 5-27 .

• Current [A] (ON and OFF)
Indicates the pulse current (ON and OFF) during the PWM period.

The input range varies depending on the range setting on the PFX2011 Charge/
Discharge Power Supply Unit.
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• Time [ms] (ON and OFF)
Set the pulse time width during the PWM period.

Current control during the PWM period varies depending on the selected/unse-
lected status of Max Voltage [V] check box. For details, see below “Current
control during the PWM period” .

• It Time [s]
When the time for detecting the minimum voltage from starting the pulse OFF
current reaches IT time, the operation moves from the PWM period to rest.

Items common to all periods

• Charge Time [h:min]
When the total time of all periods (CC, CC-Pulse, and PWM) exceeds this
value, the operation terminates charging and moves to rest. If the entry is 0:00,
charging is skipped.

• Rest Time [h:min]
Indicates the state in which nothing is performed after charging is finished and
before transiting to discharging. If the entry is 0:00, rest is skipped.

■ Current control during the PWM period

Current control during the PWM period varies depending on the Max Voltage (OFF
voltage) check box setting as follows:

When the Max Voltage (OFF voltage) check box is selected

When the battery voltage increases to the OFF voltage*1 or when the ON time
elapses during the ON current period, the operation moves to OFF current. If the
operation moved to OFF current after the ON time has elapsed, the operation moves
to ON current when the OFF time elapses. If the operation moved to OFF current
due to the battery voltage rising up to the OFF voltage, the operation moves to ON
current when the battery voltage drops to the ON voltage and the OFF time elapses.

*1 Because voltage detection requires at least 0.5 ms, the minimum ON current time is 0.5 ms.

Fig. 5-21 Transition between ON/OFF Current during the PWM Charge 
Period (When the Check Box Is Selected)

PWM period

Max. voltage (OFF voltage)
Min. voltage (ON voltage)

OFF current

ON current

OFF time

ON time
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The PWM charge period is controlled by the sequence shown in Fig. 5-22.

Fig. 5-22 ON/OFF Current Transition Sequence during the PWM 
Charge Period (When the Check Box Is Selected)

Yes

No

Yes

No

No

Yes

Yes

No

Yes

No

 

PWM charge period start

ON current

OFF current OFF current

Increase up to the
OFF voltage

Increase up to the
OFF voltage

ON time has elapsed

OFF time has elapsed

OFF time has elapsed and
dropped to the ON voltage

Clear the OFF time counter

The relationship of the current ON/OFF time

The actual current ON time ≤ ON time

The actual current OFF time ≥ OFF time
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When the Max Voltage (OFF voltage) check box is not selected
When the ON time elapses during the ON current period, the operation moves to
OFF current. During the OFF current period, the operation moves to ON current
when the battery voltage drops to the ON voltage and the OFF time has elapsed.

Fig. 5-23 Transition between ON/OFF Current during the PWM Charge 
Period (When the Check Box Is Not Selected)

The PWM charge period is controlled by the sequence shown in Fig. 5-24.

Fig. 5-24 ON/OFF Current Transition Sequence during the PWM 
Charge Period (When the Check Box Is Not Selected)

PWM period

Min. voltage (ON voltage)

OFF current

ON current

ON timeim

OOFF timeF t

Yes

No

Yes

No

PWM charge period start

ON current

OFF current

ON time has elapsed

OFF time has elapsed and
dropped to the ON voltage

The relationship of the current ON/OFF time

The actual current ON time = ON time

The actual current OFF time ≥ OFF time
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5.4.5 Discharge Conditions (Predischarge and Sequence
Sheets #1 to #15)

Here, the type of discharge test or predischarge to be executed is specifically
defined. Since the items that need to be specified vary greatly depending on the
operation mode, description will be given independently for each operation mode.
However, range selection, mode selection, capacity voltage, cutoff voltage, and tem-
perature chamber setup conditions are common to all modes.

Fig. 5-25 Test Condition > Sequence Sheets

Items independent of the mode setting

Range
You can select the range if you selected the PFX2011 Charge/Discharge Power Sup-
ply Unit for “Expected Model” in section 5.3.1, “Module.”

Depending on the range selection, the valid ranges for settings concerning current,
capacity, and power vary.

Mode
Select the mode. Select CC, CP, or CC-Pulse.

• Other modes may be included depending on the Test Condition Editor version.
However, they are for special-order features. Dimmed items are not selectable.

To select CC-Pulse or CP-Pulse, select Pulse here and then select CC or CP for
Pulse Mode to the lower right.

Discharge Time [h:min]
Set the discharge time. The discharge time is one of the factors that terminate dis-
charging. Discharging ends when this discharge time elapses. If the entry is 0:00,
discharge is skipped.

NOTE
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Rest Time [h:min]
Set the rest time after discharging has ended (state in which nothing is performed
after discharging). If the entry is 0:00, rest is skipped.

Capacity Voltage [V]
This function stops the integration of the discharge capacity when the battery volt-
age, which declines as discharge progresses, falls below the capacity voltage setting.

Fig. 5-26 Termination of the Integration of the Discharge Capacity at 
the Capacity Voltage

Cutoff Voltage [V]
The cutoff voltage is one of the factors that terminate discharging. Discharging ends
when the battery voltage falls to this voltage even if discharge time has not elapsed.

Enable Chamber Control
If this item is enabled, temperature chamber settings are performed in the cycle if
this sequence sheet is used. In this case, you must also enter Temperature [°C],
Humidity [%], Setting Timeout [min], and Wait Time [min].

Temperature [°C]
Specify the temperature setting of the chamber.

Humidity [%]
Specify the humidity setting of the chamber.

Check the control range of the temperature and humidity of the temperature cham-
ber being used. Depending on the performance of the temperature chamber, some
humidity ranges may not be possible against the specified temperature. In such case,
specify -1 and the humidity control will be disabled.

Setting Timeout [min]
The temperature chamber does not reach the specified condition immediately after
the temperature and humidity are set. If the temperature chamber does not reach the
target temperature and humidity (within the range specified in system settings) even
after the specified time elapses, the setting is considered to have failed.

Wait Time [min]
Even if the temperature chamber reaches the target temperature and humidity, you
must allow some time for the battery in the chamber to reach the temperature. This
setting specifies the wait time. If testing is performed in synchronization with the
temperature chambers, the actual discharge starts after the wait time elapses.

For details on synchronized operation of temperature chambers, see section 7.10,
“Temperature Chamber Synchronization."

Discharge time

Rest time

Battery voltage Capacity voltage
Cutoff voltage

Discharge voltage
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5.4.6 CC Discharge
Fig. 5-27 shows an illustration of the constant current discharge (CC) operation.
The figure illustrates the transition of constant current discharge → voltage drop to
the cutoff voltage → discharge termination → discharge rest.

Fig. 5-27 Illustration of Constant Current Discharge

Fig. 5-28 Test Condition > Sequence Sheet (CC Discharge)

Current [A]
Indicates the discharge current.

The input range varies depending on the range setting on the PFX2011 Charge/Dis-
charge Power Supply Unit.

Discharge time

Battery voltage
Cutoff voltage

Rest time

Discharge currentDischarge current
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5.4.7 CP Discharge

Fig. 5-29 shows an illustration of the constant power discharge (CP) operation. The
figure illustrates the transition of constant power discharge → voltage drop to the
cutoff voltage → discharge termination → discharge rest.

Fig. 5-29 Illustration of Constant Power Discharge

Fig. 5-30 Test Condition > Sequence Sheet (CP Discharge)

Wattage [W]
Indicates the discharge wattage value.

The input range varies depending on the range setting on the PFX2011 Charge/Dis-
charge Power Supply Unit.

Limit Current [A]
In constant power discharge, the discharge current increases as the battery voltage
drops. The limit current value is the upper limit value for the discharge current. 

The input range varies depending on the range setting on the PFX2011 Charge/Dis-
charge Power Supply Unit.

Discharge time

Battery voltage Cutoff voltage

Discharge current Rest time

Limit current
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5.4.8 CC-Pulse Discharge

Fig. 5-31 shows an illustration of the constant current/pulse discharge operation.
The figure illustrates the transition of pulse discharge → voltage drop to the cutoff
voltage → pulse discharge termination → discharge rest.

Fig. 5-31 Illustration of Constant Current/Pulse Discharge

Fig. 5-32 Test Condition > Sequence Sheet (CC-Pulse Discharge)

Discharge time

Battery voltage
Cutoff voltage

Pulse
discharge current

Rest time

Enlarged view

Battery voltage

Pulse
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Pulse Settings

• Num Of Pulse
Set the number of pulses per cycle.

You can set up to 8 values on the PFX2011 and 20 values on the PFX2021.

• Pulse Mode
To select CC-Pulse mode, select CC.

• Measurement
Specify the points for measuring the voltage during pulse discharging. Voltage can
be measured at two points.

The discharge cutoff voltage is detected at the lower of the measurement points,
Measurement High or Measurement Low for the PFX2011 and at the Measurement
Low point for the PFX2021.

High: Highest voltage point in the cycle

Low: Lowest voltage point in the cycle

pt1 to ptn: Point immediately before the switching of each current value

High

Select the voltage measurement point from High and pt1 to ptn (n: number of
pulses).

Low

Select the voltage measurement point from Low and pt1 to ptn (n: number of
pulses).

• Current [A]
Set each current value of pulse discharge. You can set a current value for each pulse
value.

The input range varies depending on the range setting on the PFX2011 Charge/Dis-
charge Power Supply Unit.

• Time [ms]
Set each time width of pulse discharge. You can set a time width for each pulse
value.

Cutoff Voltage [V]
The cutoff voltage is one of the factors that terminate discharging. Discharging ends
when the battery voltage falls to this voltage even if discharge time has not elapsed.
For pulse discharge, discharging is terminated when the lower of the voltage values,
Measurement High or Measurement Low, drops to the cutoff voltage for the
PFX2011 and when the voltage value of Measurement Low drops to the cutoff volt-
age for the PFX2021.
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CC-Pulse Discharge (continued)
Pulse setting example of the PFX2021

This example is for the case when detecting the discharge cutoff voltage on the high
end using two pulses.

Pulse Settings

Number of pulses: 2

Pulse mode: CC

Measurement High: Pt1

Measurement Low: Pt2

Current 1: 2.000A, current 2: 0.500 A

Time 1: 0.50 ms, Time 2: 0.50 ms

Fig. 5-33 Pulse operation, voltage measurement, and charge operation

If you set Measurement High to "High," the voltage of Pt2 is retrieved. The data is
the same as the measured voltage of Measurement Low, and the graphs overlap.

The sampling interval of the pulse voltage varies depending on the specified pulse
time. For details, see "Measurements during pulse charge/discharge operation" in
the PFX2000 Series Instruction Manual.

Pulse
1

Pulse
2

pt1

pt2

Voltage

Current

Measured pt2 voltage
(specified by Measurement Low)

Measured pt1 voltage
(specified by Measurement High)

Battery voltage

Discharge finished

Discharge
cutoff voltage

Pulse operation and voltage measurement

Charge operation
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5.4.9 CP-Pulse Discharge

You can select the CP-Pulse discharge if you selected the PFX2021 Charge/Dis-
charge Power Supply Unit for “Expected Model” in section 5.3.1, “Module.”

Fig. 5-34 shows an illustration of the constant power pulse discharge operation. The
figure illustrates the transition of constant power pulse discharge → voltage drop to
the cutoff voltage → pulse discharge termination → discharge rest.

Fig. 5-34 Illustration of Constant Power Pulse Discharge

Fig. 5-35 Test Condition > Sequence Sheet (CP-Pulse Discharge)

Discharge time
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Limit current
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Pulse Settings
For the setting example, see the pulse setting example for CC-Pulse discharge.

• Num Of Pulse
Set the number of pulses for pulse discharge.

• Pulse Mode
To select CP-Pulse mode, select CP.

• Measurement
Specify the point for measuring the voltage during pulse discharging. Voltage can be
measured at two points.

The discharge cutoff voltage is detected at the lower of the measurement points,
Measurement High or Measurement Low for the PFX2011 and at the Measurement
Low point for the PFX2021.

High: Highest voltage point in the cycle

Low: Lowest voltage point in the cycle

pt1 to ptn: Point immediately before the switching of each current value

High

Select the voltage measurement point from High and pt1 to ptn (n: number of
pulses).

Low

Select the voltage measurement point from Low and pt1 to ptn (n: number of
pulses).

• Power [W]
Set each power value of pulse discharge. You can set a power value for each pulse
value.

• Time [ms]
Set each time width of pulse discharge. You can set a time width for each pulse value.

• Limit Current [A]
In constant power discharge, the discharge current increases as the battery voltage
drops. The limit current value is the upper limit value for the discharge current.

Cutoff Voltage [V]
The cutoff voltage is one of the factors that terminate discharging. Discharging ends
when the battery voltage falls to this voltage even if discharge time has not elapsed.
In pulse discharge, discharging ends when the Low voltage of Fig 5-34 falls to the
cutoff voltage.

Update time

In CP-Pulse discharge, the discharge current is controlled by software computation.
The settling time (update time) from the voltage measurement by the ADC to the
computation and the assignment of the discharge current is constant (2 ms typ.),
independent of the pulse time width. For pulse discharge, discharging is terminated
when the lower of the voltage values, Measurement High or Measurement Low,
drops to the cutoff voltage for the PFX2011 and when the voltage value of Measure-
ment Low drops to the cutoff voltage for the PFX2021.
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5.5 Copy Function of Test Conditions between 
Sheets

On the sequence sheet edit screens, charge and discharge settings can be copied and
pasted.

■ Copying the contents of the current sheet to other sheets

Fig. 5-36 Copying to Other Sheets

To copy the contents of the sheet that you are currently editing to other sheets, click
the Copy To button on the sheet edit screen. A dialog box for selecting the copy
destination appears. Select the copy destination sheet number or (All) and then click
OK. Select the Charge Sheet(s) or Discharge Sheet(s) checkbox or both check-
boxes. The selected items (charge/discharge) are copied to the specified sheet num-
bers.

■ Copying the contents of another sheet to the current sheet

Fig. 5-37 Copying from Another Sheet

To copy the contents of the another sheet to the sheet that you are currently editing,
click the Copy From button on the sheet edit screen. A dialog box for selecting the
copy source appears. Select the copy source sheet number and then click OK.
Unlike the copy function to other sheets, (All) is not available as a selection. Select
the Charge Sheet(s) or Discharge Sheet(s) checkbox or both checkboxes. The
selected items (charge/discharge) are copied from the specified sheet number.
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5.6 Preference Settings of the Test Condition 
Editor

You can set the preference settings of the Test Condition Editor by choosing
Options from the Tools menu.

Fig. 5-38 Preference Settings

Unit Display
Select the unit displayed on the Form Pane.

• The resistance unit setting is applied only to the CR charge/discharge value.

• The battery impedance is always displayed in [Ω].

Show error messages for invalid input values
If this checkbox is selected, an error message is displayed when you enter a value
outside the input range. If this checkbox is not selected and you enter a value out-
side the input range, the value is highlighted to indicate that it is not valid.

Enable Auto Complete for text inputs
If the check box is selected, the auto complete function is enabled. If you enable this
function, text you entered referred to the history of initial character of the text
entered in the past.

Fig. 5-39 Auto complete function example

Selection

Current A or mA

Capacity mAh or Ah

Wattage W or mW

Resistance Ω or kΩ

NOTE
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Chapter 6 Preparations for Test 

Execution

This chapter describes items that you should check and items you need to configure
before starting the actual test.
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6.1 Test Executive

The Test Executive is a program that executes charge/discharge tests according to
the test conditions file that you created using the Test Condition Editor.

Starting the Test Executive

To start the Test Executive, double-click the shortcut icon of the Test Executive pro-
gram from the Windows desktop folder or program folder.

Fig.6-1 Test Executive Screen

The Test Executive consists of four panes.

Controller/Group Pane
The pane on the left side of the screen is called the Controller/Group Pane. 

You can switch between controller view mode that organizes information according
to the system of control unit connections and group view mode that organizes infor-
mation according to test execution groups.

To switch the display mode, click the Controller tab or Group tab at the bottom sec-
tion of the Controller/Group Pane on the left side of the screen.

Channel Pane
The pane at the upper right of the screen is called the Channel Pane. This pane dis-
plays all the channels that belong to the controller or group that is selected (high-
lighted) in the Controller/Group Pane and their execution status. The displayed
contents vary between controller view mode and group view mode.

Graph Result Pane
The pane at the lower right of the screen is called the Graph Result Pane. This pane
displays a summary of the realtime graph, the test conditions that are used, and the
test results for the channel that is selected (highlighted) in the Channel Pane. The
summary is not displayed for channels whose test is not in progress.

Controller/
Group Pane

Graph Result 
Pane

Chamber Pane

Channel Pane
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The current status is indicated by the displayed color of the list as follows:

Chamber Pane
The Chamber Pane shows the temperature chamber operation. This pane does not
appear, if the number of controllers is set to 0 (indicating that the temperature cham-
ber is not used) in the dialog box that appears when you select System Config from
the Tools menu.

For details on synchronized operation of temperature chambers, see section 7.10,
“Temperature Chamber Synchronization”s."

6.2 Start Conditions and Troubleshooting

When you start the Test Executive, the previous start conditions are restored. Here,
“condition” refers to the connection status of each hardware, group binding status,
test progress status of each channel, the assignment status of test conditions, and
other status.

When starting the Test Executive for the first time, it is recommended that the hard-
ware be configured in advance using the Hardware Configuration Wizard program.
If the Test Executive is started after executing the Hardware Configuration Wizard,
the program will start using the conditions created by the Hardware Configuration
Wizard (controller and channel identification) and the group created by the Group
Administrator or the Test Condition Editor.

While starting up, the Test Executive program connects to the control units (1 or 2)
that were configured by the Hardware Configuration Wizard via the USB and ini-
tializes the channels.

The program will start normally, if there is no change to the hardware configuration
specified by the Hardware Configuration Wizard. However, if the specified condi-
tions and the actual hardware configuration differ when the Test Executive is
started, any of the following communication errors may occur.
• USB communication error with the controller
• I/O communication error with channels
• I/O communication error with the impedance units
• Communication error with the temperature chamber

If the Test Executive detects the entire hardware configuration correctly, the names
of the detected control units and channels appear on the Test Executive screen. If
there is a problem with the detection at startup, the behavior of the Test Executive
varies depending on the location of the problem.

To check the control units and channels after the Test Executive is started, select
(highlight) the corresponding unit or group on the Controller/Group Pane.

Red: Charging

Green: Discharging

Orange: Resting

Normal color: Some other status
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6.2.1 If the Test Executive Cannot Identify Controllers

In this case, the Test Executive displays an error message at startup. When you click
OK to close the error message, the Test Executive shows the normal screen. Since the
controller unit has not been identified, no icons are displayed in the controller view of
the Controller/Group Pane. (Normally an icon and instrument ID are displayed.)

Fig. 6-2 Condition in Which Controller Units Are Not Identified

It is often the case that the control units are not identified by the PC as USB devices.
In this case, first check that the USB cable is connected properly. If it is, start Device
Manager from Windows Control Panel, and check that the control unit is identified as
a USB device. If it is being identified properly, you can view the Instrument ID by dis-
playing the properties of the device. Check that the setting is correct. The proper ID
setting is 1 if there is one control unit, 1 and 2 if there are two control units. 

If you correct the problem and the PFX2121 device is identified properly, display
the properties of the control unit on the Test Executive. To show the properties of
the control unit, right-click the corresponding control unit and select Properties
from the shortcut menu. The dialog box displays the Model Name as (ID number)
and the Status as Unplugged.

To reconnect, click Plug Controller. If the Status changes to Plugged a few seconds
later, reconnection is complete.

If the connection still does not work, it is recommended that you exit the Test Exec-
utive; reset the control unit (remove the USB cable and reconnect); and then start
the Test Executive again.

Fig. 6-3 Unplugged example Fig. 6-4 Plugged example

No icon
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6.2.2 If the Test Executive Identifies Controllers But Not the
Channels

In this case, the Test Executive does not display an error message at startup. How-
ever, in most cases, the program takes longer to start (more than 10 s) than in the
normal case. This is because the control unit takes longer in identifying the channels
via the TP-BUS. The Test Executive shows the normal screen, even if it fails to
identify the channels.

Fig. 6-5 Condition in Which the Channels Are Not Identified

In this case, the name of the control unit is displayed properly. Click the control unit
name. The Channel Pane displays a list of channels that should be connected to the
control unit. Note that icons are not displayed to the right of the channels that are
not identified.

The possible reasons for this type of problem are improper connection of the TP-
BUS or improper insertion of charge/discharge power supply units in the frame.
Check these connections again.

After correcting the problem, carry out manual identification on a channel basis.
Click the name of the channel with the problem to select it and then right-click to
display the shortcut menu. And choose Recognize from the menu. Identification is
performed on the selected channel.

If the identification succeeds, a OFF icon is displayed to the left of the channel
name.

Fig. 6-6 Identification on a Channel Basis

No icon

OFF icon
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6.2.3 If the Test Executive Cannot Identify Impedance Mea-
surement Units

If the impedance measurement unit is selected in the system configuration, the Test
Executive checks the connection of the impedance measurement unit that is con-
nected to the corresponding controller at startup. If the identification fails, the Test
Executive displays an error message. When you click OK to close the error mes-
sage, the Test Executive shows the normal screen.

The frequent causes of this error message are the improper TP-BUS connection
between the impedance measurement unit and the control unit and the impedance
measurement unit not being powered up.

After correcting the problem, display the control unit properties. To show the prop-
erties of the control unit, right-click the control unit to which the impedance mea-
surement unit is connected and select Properties from the shortcut menu. The
dialog box shows that the controller itself is plugged, but the impedance measure-
ment unit is unplugged. Click Plug Impedance to connect the impedance measure-
ment unit.

Fig. 6-7 Connection of the Impedance Measurement Unit

It the connection still does not work, it is recommended that you exit the Test Exec-
utive once, wait a few seconds, and start the Test Executive again.
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6.2.4 If the Test Executive Cannot Identify Temperature
Chambers

If the number of temperature chambers is set to 1 or greater in the system configura-
tion, the Test Executive communicates with the temperature chambers to identify
them at startup. If the temperature chambers are not connected correctly via GPIB
or RS232C or if VISA is not set setup correctly, identification fails, and the Test
Executive displays an error message. When you click OK to close the error mes-
sage, the Test Executive shows the normal screen. Because the temperature cham-
bers have not been identified, a communication error is displayed in the Chamber
Pane.

Fig. 6-8 Communication error with the temperature chambers

See the respective instruction manual and connect the temperature chambers cor-
rectly.

After connecting the temperature chambers correctly, right-click on the Chamber
Pane and choose Recover Connection. The communication resumes, and the tem-
perature chambers are identified. If the temperature chambers fail to be identified
even when you choose Recover Connection, close the Test Executive once, wait a
few seconds, and restart the Test Executive.

6.3 Creating Groups and Binding Channels

On the Test Executive, all actions concerning test execution are performed against
groups or channels bound to groups. You cannot assign test conditions to or execute
tests on channels that are not bound to any groups. In addition, such channels do not
appear on the screen in group view mode. Therefore, channels on which you wish to
execute tests must be bound to some group.

6.3.1 Creating Groups

Though not really necessary if groups have been created using the Group Adminis-
trator or the Test Condition Editor, you can also create new groups or delete existing
groups while the Test Executive is running.

To create or delete groups, use the Group Administrator. From the Group menu of
the Test Executive, choose Launch Group Administrator.

The changes to the group binding made using the Group Administrator are not
immediately applied on the Test Executive screen. You can refresh the screen by
choosing Refresh from the View menu of the Test Executive.
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6.3.2 Binding Channels to Groups

Simply creating groups using the Group Administrator or Test Condition Editor
does not bind the channels to the groups. Therefore, you must first bind the channels
to a certain group.

To bind channels to a group, choose Bind/Unbind Channels from the Test menu in
group view mode. A dialog box used to bind and unbind channels appear. Use this
dialog box to bind the channels.

Fig. 6-9 Bind To Group/Unbind From Group

The left side is a list of channels as viewed from the controller. However, channels
that are already bound to a group are not displayed. The right side is a list of chan-
nels as viewed from the group. Select one or more channels you wish to bind or
unbind and click Bind or Unbind as necessary.

The list on the controller side displays all the channels controlled by the corre-
sponding controller that are not bound to any group.

On the group side, channels that are bound to the corresponding group are dis-
played. However, only those channels that can be unbound (those that can be
unbound without causing a problem) are displayed. Since channels that have test
conditions assigned to them and are in a monitor loop or those that are executing the
test (normally indicated by IDLE or RUN icons) cannot be unbound, they are not
displayed even through they are bound to the group.

However, channels that are indicated as IDLE can be bound or unbound if the test
conditions have not been assigned to them (simply moved to plugged status).
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Chapter 7 Executing Tests

This chapter describes the procedures for starting the actual tests.

Refer to the previous chapter for items that should be checked before starting the
tests as necessary.
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7.1 Test Execution Panel

The Test Execution Panel is a panel (dialog box) that is frequently used in the Test
Executive program. All operations for starting and stopping tests are performed
from this panel.

Fig.7-1 Test Execution Panel

Below are the four types of operations concerning test execution.

Table7-1 Operation Concerning Test Execution

These operations are carried out from the Test menu or the Toolbar. 

The Test Execution Panel screen is similar for all operations. However, an indica-
tion such as [START] and [STOP] is added to the end of the title (on the title bar).

The Test Execution Panel is displayed with the groups divided into tabs. The items
on the panel are explained below.

Start
Starts the tests. This includes restarting of tests that are currently 
stopped.

Stop Stops the tests. You can restart tests that are stopped.

Empty
Clears the test data and prepares for a new test to be started. The 
record of test results is moved to the backup folder.

Reset Alarm
Resets the alarms on channels whose alarms are activated. Channels 
are automatically stopped when alarms occur.
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Chamber Synchronization
When performing synchronized operation with temperature chambers, the selected
temperature chambers are assigned at the group level.

For details on synchronized operation of temperature chambers, see section 7.10,
“Temperature Chamber Synchronization."

For All Channels  Test Conds
Assigns the selected test conditions to all channels in the group.

For All Channels  Stop When
Specifies the process timing for stopping tests on all the channels in the group.

Channels on this group
This large list displays all the channels that are bound to the current displayed group
(selected by the tab).

The boxes at the left end function like checkboxes. However, the checkboxes for
lines (channels) whose characters appear dimmed cannot be selected.

The icons to the right of the checkboxes are the same as those shown in the Channel
Pane. The icon is followed by the channel name, Model ID, and cycle number. If the
channel is executing the test, the cycle number indicates the number of the cycle
that is currently being executed. Otherwise, cycle indicates the number of the cycle
of the test that has been completed. On channels starting a new test, 0 is displayed.
To the right of the cycle is the name of the test condition that is assigned to the chan-
nel.

Select All
Selects all the displayed channels. This is equivalent to selecting all the channels
one by one (selecting the checkboxes at the left end). However, channels that appear
dimmed are not selected.

Determines whether the action (start operation in the case of Test Execution Panel
[START]) is executed on the selected channel.

Unselect All
Clears all the selected channels at once. However, channels that appear dimmed are
not cleared.
BPC2000 Executing Tests  7-3



7.2 Starting the Tests

You must assign test conditions before starting the tests. This is done on the Test
Execution Panel [START].

7.2.1 Assigning Test Conditions

There are two methods for assigning test conditions.
• Assign the same test conditions collectively to all the channels in the group.
• Assign different test conditions for each channel.

Choose Start from the Test menu to display the Test Execution Panel [START].

Fig. 7-2 Test Execution Panel [START] (Test Conditions Not Assigned)

When performing tests in synchronization with the temperature 
chambers

If you are performing tests in synchronization with the temperature chambers, you
must specify the number of the temperature chamber you wish to assign to this
group from the Chamber Synchronization box. For details on synchronized opera-
tion of temperature chambers, see section 7.10, “Temperature Chamber Synchroni-
zation”.

• Assign temperature chamber numbers before assigning test conditions.
If the test conditions are assigned first, the Chamber Synchronization box will
appear dimmed, and you will not be able to specify it.

NOTE
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■ Assigning the same test conditions collectively to all the 
channels in the group.

Click Test Conds to open a dialog box used to select the test conditions that have
been created before. Select a single test conditions file. The selected test conditions
are assigned to all the channels in the group.
However, assignment is not made on channels that are already executing the test. In
addition, if the cycle number display is 1 or more (1 or more cycles of the test have
been completed), the assignment is not made (because it would change the assign-
ment of the test conditions in the middle of the test).

Fig. 7-3 Collective Assignment of Test Conditions

■ Assigning different test conditions for each channel

To assign different test conditions to each channel, first click the desired channel to
select it. A menu button is added to the Test Condition item of that channel. Click
the button and select the test conditions you wish to assign from the menu. Choos-
ing a blank test conditions name frees the test conditions.

However, you cannot change the assignment of the test conditions or free the test
conditions on channels that are currently executing the test or those that are stopped
after completing one or more cycles (cycle display is 1 or more).

Fig. 7-4 Assignment of Test Conditions to Each Channel

Test conditions that have been assigned can be changed before the execution of the
tests. Therefore, if you wish to assign the same test conditions to all the channels
except one channel, you can click Test conditions to collectively assign the test con-
ditions to all the channels and then change the test conditions of a particular channel
separately.
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• If test conditions cannot be assigned to a channel

Check the status display in the Channel Pane. Test conditions cannot be assigned
to channels that have #0002 or #0003 shown. These status codes indicate warn-
ings. For conditions that cause warnings to appear, see appendix A.2.1, "Alarm
and Warning Concepts."

Warnings can also be confirmed on the panel LED of the charge/discharge power
supply unit.

■ Changing the sample name for each channel.

By default, the sample name of each channel that is displayed in the channel list is
the name that was entered at the battery info of the Test Condition Editor. This sam-
ple name can be changed for each channel.

If you highlight the desired channel, the Sample Name item turns into a combo box.
Enter the new name in the box. The entered name is displayed in a list, and you can
select it from that point.

7.2.2 Executing Tests

You can either operate all channels collectively or each channel individually (or a
mixture of the two). Assign the test conditions to channels on which you wish to
execute the test. Channels that are assigned test conditions immediately become
plugged status (connected status) and enter the monitor loop. At this point the icon
display changes to IDLE.

The display of the line corresponding to channels that are indicated with the IDLE
icon change from dimmed to normal (black), and the checkbox becomes selectable.
In rare cases, some channels remain dimmed (unselectable) even when test condi-
tions are assigned. On such channels, some type of warning is in effect concerning
the test execution (hardware protection warning, connection check warning, etc.).
Tests cannot be executed on such channels.

Finally, select the channels (select the checkboxes) on which you wish to start the
test and click OK.

Fig. 7-5 Selection of Corresponding Channels

NOTE
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Overwriting of existing test data

If a test has already been executed and you
attempt to execute another test without clear-
ing the data as described in section 7.5,
“Deleting the Test Data Contents,” a data stor-
age warning dialog box appears.

When a test is started or re-executed, the Test
Executive always checks to see if there are
files present in the test data generation folder.
This is to prevent overwriting existing test
data inadvertently. The warning will appear if
there are any files in the test data generation
folder. If the test data generation folder is
deleted, a folder is created.

If a presence of a file is detected, the Test
Executive displays the data storage warning
dialog box. The data storage warning box appears for all channels that fail the
check.

In the dialog box, you select whether to back up the data folder. The default setting
is to back up the data folder.

Which action do you take?
• Do not proceed test

If you select this action, nothing is executed. This is the same as clicking Cancel on
the Test Execution Panel [START].
• Backup existing data, then proceed test (default)

If you select this action, the data folder is renamed, and all of the test data in the
data folder are backed up.
• Proceed test overwriting existing data

If you select this action, the data folder is not backed up, and the existing test data is
deleted.
• View Folder

If you click this button, Windows Explorer starts displaying the corresponding data
folder.

Backup Options
If you selected Backup existing data, then proceed test (default), you will be able
to enter the Folder Suffix and Memo boxes.

The folder suffix is a name that is added when the data folder is renamed. By
default, the folder suffix is set to the date/time when the dialog box was opened.

Memo is for writing a comment for the backup action. A text file containing the
memo is created in the folder that is backed up.

Fig. 7-6 Data Storage Warn-
ing Dialog Box
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When multiple channels fail the check
The data storage warning box appears for all channels that fail the check. If you
wish to change the back up procedure for each channel, you will need to set each
dialog box and click OK.

If you wish to perform the same backup procedure for all selected channels, you can
use the two options at the bottom of the first dialog box to omit the rest of the oper-
ations.

If you select the Apply the same action for all channels checkbox, the action of
the next dialog box is set to the same action selected previously. In addition, the Do
not show this dialogue for subsequent channels checkbox becomes available. If
you apply this option, the following dialog boxes do not open, so you only have to
enter settings on one dialog box.

7.3 Stopping Tests

In the stop operation, you must specify the timing when the stop process is actually
applied. This operation is performed on the Test Execution Panel [STOP]. There are
two methods for specifying the timing.

• Specify the same timing to all the channels.
• Specify the timing individually on each channel.

To stop the tests, choose Stop from the Test menu. Test Execution Panel [STOP]
appears.

■ Specify the same timing to all the channels.

Click the Stop When button at the top section of the screen. A menu appears of the
button. The following 4 menu commands are available.

Table 7-2 Menu of Stop When

*1 Scheduled stop indicates the method of stopping the test. It is specified on a channel
that continues the test even when it is instructed to stop (channel that is instructed to
stop at the end of the phase or cycle).

Don’t Stop
Selected by default.
You can select Don’t Stop, if you do not wish to stop the channel that 

is already scheduled to stop. * 1

Immediately
The test is immediately stopped regardless of the progress status of 
the test. (The test does not stop simply by selecting the menu.)

Phase End

The stop process is performed when the current charging or discharg-
ing is finished, and the test stops after the phase (charge or discharge 
phase) being executed has been completed.
 (The test is not immediately stopped.)

Cycle End
The stop process is performed at the end of the current cycle, and the 
test stops after the current cycle (one of the test condition patterns) 
has been completed. (The test is not immediately stopped.)
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After deciding on the action concerning the stopping of the test, select the channels
you wish to stop (or channels you wish to enable scheduled stop) (select the check-
boxes) and click OK. This will carry out the stop process.

Fig. 7-7 Specifying Stop When Collectively

■ Specifying the timing for each channel individually

First click the desired channel to select it. A menu button is added to the Stop When
item. Click the button and select when to stop the test from the menu. The Stop
When selections are the same as with the all-channel operation.

Fig. 7-8 Specifying Stop When Individually

7.4 Terminating Tests

Test termination signifies the completion of all test cycles that are scheduled by the
test conditions. Normally, the end of the test is reached automatically by performing
all test schedules.

When all test cycles have been completed, the channel is indicated as END and is
removed from the monitor loop. Therefore, in normal cases, you do not have to spe-
cifically carry out a test termination operation. However, there are cases when you
wish to forcibly terminate the tests (handle the tests as terminated). In such cases,
carry out the procedures described here.

To terminate the test, the channels that you wish to terminate must be stopped. For
the procedure in stopping the test, see section 7.3, “Stopping Tests.”

To terminate the tests, select the desired channels from the Channel List Pane, and
choose Toggle End Mark from the Channel menu. This operation can also be used
to remove the END marks from the channels that already have END marks.
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7.5 Deleting the Test Data Contents

There may be instances when you wish to clear the existing test data and execute a
new test on the same channel. Such examples include the case when you wish to
execute the test from scratch after performing a test run on the DUT (battery) or the
case when you wish to execute a test on a new DUT (battery) on the same channel
after wrapping up the previous test.

In such cases, you must clear the data on the corresponding channels to free them.
This operation achieves the task.

To clear the test data, choose Empty from the Test menu. Test Execution Panel
[EMPTY] appears.

Fig. 7-9 Test Execution Panel [EMPTY]

The operation here simply selects the channel on which you wish to empty the data
(multiple selections possible). Channels that are executing the test appear dimmed
and cannot be selected.

Click OK to display the data backup dialog box of the selected channels.

In the dialog box, you select whether to back up the data folder.

The default setting is to back up the data folder.

Fig. 7-10 Data Backup Dialog Box
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Which action do you take?
• Do not backup the folder

If you select this action, the data folder is not backed up, and the existing test data is
deleted.
• Backup the folder (default)

If you select this action, the data folder is renamed, and all of the test data in the
data folder are backed up.
• View Folder

If you click this button, Windows Explorer starts displaying the corresponding data
folder.

Backup Options
If you selected Backup the folder, you will be able to enter the Folder Suffix and
Memo boxes.

The folder suffix is a name that is added when the data folder is renamed. By
default, the folder suffix is set to the date/time when the dialog box was opened.

Memo is for writing a comment for the backup action. A text file containing the
memo is created in the folder that is backed up.

When multiple channels whose data is to be deleted are selected
The data backup dialog box appears for all selected channels. If you wish to change
the back up procedure for each channel, you will need to set each dialog box and
click OK.

If you wish to perform the same backup procedure for all selected channels, you can
use the two options at the bottom of the first dialog box to omit the rest of the oper-
ations.

If you select the Apply the same action for all channels checkbox, the action of
the next dialog box is set to the same action selected previously. In addition, the Do
not show this dialogue for subsequent channels checkbox becomes available. If
you apply this option, the following dialog boxes do not open, so you only have to
enter settings on one dialog box.

■ Using the test data that has been backed up

The test data folder that has been backed up is renamed by adding a folder suffix
and is distinguished from the group and channels with the same names currently
executing the test. You can analyze the backup data using the Graph Viewer even
after the data is moved. In addition, you can copy the test data that has been backed
up to a removable media such as MO and CD-R as necessary. If the backup data is
not necessary, simply delete the data. Carry out these operations using Windows
Explorer.

■ Executing a new test

The channels whose test data has been emptied are reset (completed cycle number is
0 and test conditions not assigned). However, the channel name and group binding
remain. To execute a new test, follow the procedures given in section 7.2, “Starting
the Tests.”
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7.6 Resetting Alarms

If an alarm occurs during the test, the test on the corresponding channel is automat-
ically stopped at the charge/discharge power unit. The test results of the phase cur-
rently in execution (either charge result data or discharge result data) are retrieved
and saved to a file. The icon of the channel on which an alarm occurred changes to
ALM. You must correct the cause of the alarm on such channels and execute the test
again.

There are two methods for resetting the alarm.

Using the Test Execution Panel [RESET ALARM]
From the Test menu, choose Reset Alarm. Test Execution Panel [RESET ALARM]
appears.

There are no detailed settings in the operation of resetting alarms. Simply click the
Select All button to collectively select all the channels or select the channels indi-
vidually, and then click OK.

This method is convenient when alarms occur on all the channels and you wish to
select all the channels to be reset. However, you must open the Test Execution Panel
[RESET ALARM].

Using reset alarm on the toolbar
Select the channel whose alarm is to be reset on the Channel Pane, and click the
reset alarm icon on the toolbar.

This method allows you to reset alarms without opening the Test Execution Panel
[RESET ALARM].

Fig. 7-11 Toolbar

7.7 Restarting Tests

To restart the test when the test has been stopped or when you reset the alarm after
an alarm occurrence, carry out the same procedure as starting the test. Choose Start
from the Test menu to display the Test Execution Panel [START]. 

Confirmation before restarting the test
Note the cycle numbers indicated on the screen. For channels whose test is in
progress (indicated by a RUN icon), the number shows the number of the cycle that
is currently being executed; for other channels, the number shows the number of the
cycle that has been completed. For example, if the channel whose test is not in
progress is indicated as 1, the completed cycle is 1. This means that the number of
the cycle at which the test should be restarted is 2. If the number is 0, it indicates
that there are no completed cycles. Channels that are indicated as 0 are handled
exactly the same as a new execution. In this case, the assigned test conditions can be

Reset alarm
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changed. For other cases, the assigned test conditions cannot be changed, because
there are cycles that have been completed already.

Even in the case in which the assigned test conditions cannot be changed, the con-
tents of the test conditions concerning the successive cycles can be changed if they
are within the same test conditions. For details on changing the test conditions, see
section 7.9, “Changing the Test Conditions during the Test."

In addition, completed cycle numbers can be changed by choosing Increment
Cycle Number +1, Decrement Cycle Number -1, or Enter Cycle Number on the
Channel toolbar or menu.

Fig. 7-12 Channel toolbar

Fig. 7-13 Entering a completed cycle number

Restarting Tests
To restart the test, click the Select All button at the bottom section of the screen to
collectively select all channels or select the channels individually, and then click
OK.

When you click OK, the data storage warning dialog box appears.

This dialog box is used to determine the handling of the existing test data. For
details on the dialog box, see “Overwriting of existing test data” in section 7.2.2,
“Executing Tests.”

7.8 Emergency Stop Function

The Test Executive provides a function for stopping all charging/discharging opera-
tions for emergency situations. Choose Emergency Stop from the Test menu. In
this case, the Test Execution Panel does not appear. The charging/discharging oper-
ation is immediately stopped on all the channels.
BPC2000 Executing Tests  7-13



7.9 Changing the Test Conditions during the 
Test

The Test Executive provides a function for changing the test conditions of channels
whose test is already in progress.

This function does not reassign a different test conditions file to the channel that is
executing the test. Rather, this function changes the contents of the test conditions
for the following cycles within the same test conditions file.

To change the test conditions, select the desired channel and then choose Edit Test
Conditions from the Channel menu. The Test Condition Editor starts with the test
conditions assigned to that channel loaded. Change the test information as neces-
sary and save (overwrite) the file. The new test conditions are applied when charg-
ing is started on the next cycle or when you restart the test after stopping it once.

Constraints on Changing Test Conditions during the Test

There are constraints on changing test conditions while the test is in progress. Use
caution when using this function.

The changes made to the test conditions are not applied immediately.
The new test conditions are applied when charging is started on the next cycle or
when you restart the test after stopping it once. They are not changed immediately
while the test is in progress. The changes cannot be applied at the discharge section
within the cycle.
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The assignment of test conditions cannot be changed.
Only the test conditions within the same file name can be changed. Once the test is
started, you cannot assign a different test conditions file.

The changes apply to all the channels sharing the same test conditions.
If the same test conditions are shared among multiple channels, changing the test
conditions affect all the channels sharing them. Changes cannot be made to individ-
ual channels.

Does not affect cycles that have already been completed.
Changes cannot be made on the cycles that have been executed already. For exam-
ple, suppose cycle 20 uses test conditions sequence sheet #2. Even if you change the
contents of test conditions sequence sheet #2 while cycle 20 is in progress, cycle 21
will not accept the changes if cycle 21 is set to use sequence sheet #3. However, you
can also change the repeat settings of a sequence while test is in progress. In this
case, you can change the information. By the same token, if the total number of
cycles after the change is smaller than the number of the cycle that is currently
being executed, the entire test is terminated when the test moves to the next cycle.

When using a common sequence template, other test conditions are affected
If you change items such as the sequence, repeat loops, and temperature chamber
setup conditions in test conditions using a common sequence template, other test
conditions that use the same template are also changed. In this case, other channels
using the affected test conditions are also affected.

Scheme of Changing Test Conditions

When the test is executed, the Test Executive loads the test conditions and creates a
copy of the information for execution at the point the cycle starts (charging starts).
The Test Executive refers to the copy while the cycle is being executed. When the
cycle is complete, the Test Executive creates a test result file. The test condition data
that is included in the file is also the copy of the information.

On the other hand, the changes you make using the Test Condition Editor while the
test is in progress apply to the original file, not the copy. The Test Executive is not
affected while the test is in progress, because it does not refer to the original file. It
creates a copy from to the original file at the start of the next cycle or when the test
is restarted from the stopped status. This is the reason why the changes to the test
conditions are applied to the next cycle or when the test is restarted. In addition,
because the original test conditions that are assigned to multiple channels are read
simultaneously, changing the test conditions affect all relevant channels.
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7.10 Temperature Chamber Synchronization

You can perform synchronized tests with temperature chambers at the group level
using the Test Executive.

7.10.1 Overview of Performing Tests in Synchronization with
the Test Chambers

The charge/discharge test progresses while the channels in the same group controls
the temperature chambers according to the specified temperature and humidity set-
tings. The starting of the charge/discharge is always synchronized within the same
group.

Fig. 7-14 Synchronized operation of temperature chambers

"Temperature chamber setting up" indicates the state until the monitored tempera-
ture and humidity in the chamber enter the specified margin range.

The wait time is the time until the specified temperature and humidity stabilize, and
the DUT warms up.

Fig. 7-15 Temperature chamber setting up, waiting, and charge/dis-
charge start

If the setting timeout is exceeded while setting up, the Test Executive determines
that the temperature chamber is abnormal and aborts the test.

Set the setting timeout value and wait time in the Charge or Discharge tab in Test
Conditions > Seq Sheets. See section 5.4, “Seq Sheets."

If you set the wait time to 0 min, a wait time of 30 seconds is inserted internally.

If you set the charge (discharge) time + rest time to 0 min, a rest time of 59 seconds
is inserted internally.

Test conditions

Channel 1  test1.bpct
Channel 2  test2.bpct
Channel 3  test1.bpct
Channel 4  test1.bpct

Wait time

Charge start

Temperature
chamber
setting up

Temperature
chamber
setting up

Wait time

Discharge start

Charge + rest DisCharge + rest

25 °C 45 °C

Charge/discharge start

Setting up
Within the 

[setting timeout]
Waiting

[Wait time]

Setting

Temperature chamber
temperature and humidity

Time

Setting margin (±)
7-16  Executing Tests BPC2000



Set the temperature and humidity margins in the temperature chamber configuration
of the Hardware Configuration Wizard. See section 3.2, “Configuring the Hard-
ware."

You can set the temperature and humidity of the temperature chamber when the test
is completed. Set the room temperature to prevent unnecessary damage to the DUT.
See section 5.3.8, “Sequence."

7.10.2 Required Equipment

Temperature chambers by Espec Corporation are supported.

Up to six temperature chambers can be controlled using the following interface.
• RS232C interface
• GPIB interface

For details, see "Communications with the temperature chamber" on page P-4.

When the working environment is ready, turn on all protocol converters, RS485-to-
RS232C adapters, and temperature chambers before starting the Test Executive. The
Test Executive performs control taking Num of Chambers specified on the tempera-
ture chamber configuration screen of the Hardware Configuration Wizard to be the
upper limit.
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7.10.3 Common Sequence Templete

To perform the test in synchronization with the temperature chamber, all the chan-
nels that are to be synchronized must belong to the same group. Moreover, the test
conditions of all the channels that are to be synchronized must have unified
sequence information and temperature chamber setup information. For example,
test conditions in which the temperature setting differs among channels cannot be
executed simultaneously.

BPChecker2000 manages the settings related to the sequence function and the set-
tings related to the temperature chamber in separate files (common sequence tem-
plate files) so that the information can be shared among multiple test conditions
files. Different test conditions can be mixed within the group that is performing syn-
chronized temperature chamber control, and yet prevent discrepancies in the set-
tings related to the sequence repetition and the temperature chamber information. If
all the synchronized channels are to use the same test conditions, there is no need to
use the common sequence template file.

Fig. 7-16 Separation of Sequence Information

The settings of the following items are stored in a common sequence template file.

Test Conditions > Sequence

Test Sequence

Perform Startup Discharges

Set Chamber When Finished/Aborted

Test Conditions > Seq Sheet > Charge/Discharge

Enable Chamber Control

Do Predischarge when the sheet is first used

The Common Sequence Template is used in the following cases when performing
tests in synchronization with the temperature chambers.
• When simultaneously executing tests with different test conditions in a group

using the same temperature chamber.
• When simultaneously executing tests using different power supply modules

(PFX2011 and PFX2021) in a group using the same temperature chamber.

X.SI

A.BPCT B.BPCT C.BPCT D.BPCT

When enabled When disabled

(Sequence information: repeat, temperature, and other data)
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Creating a Common Sequence Template

1. Set the test conditions you want to save in the Common Sequence
Template.

2. In Test Conditions > Sequence, select the Use Common Sequence
Info check box.

3. Enter the sequence information name (file name).

Enter the name using 1 to 63 characters. Characters that are improper for file
names (<>.,/+- etc.) cannot be used.

Fig. 7-17 File name "ChamberSync" example

4. To save the file, choose Save or Save As from the File menu.

The Common Sequence Template file is created automatically in the same
folder as the normal test conditions file (.bpct extension) with the name
<SequenceInfoName>.si (SequenceInfName is the name specified for the
sequence information name).

Using the Common Sequence Template File

1. Create a test conditions file on which you want to use the common
sequence template file.

Create the file in the same folder (group) as the common template file to be
used.

2. To perform tests in synchronization with the temperature chambers,
change "Expected Model" under Test Conditions > Module.

See section 5.3.1, “Module."

3. In Test Conditions > Sequence, select the Use Common Sequence
Info check box.

4. Enter the common template file name to be used.

Click the ▼ at the right of the combo box to show the sequence information
names that were saved in the past.

If test conditions that are different from the template file are specified, they are
changed to the settings of the common template file before the common tem-
plate file name is entered.

5. On the File menu, choose Save or Save As to save the file.

The settings are saved (.bpct extension). The common template file is overwrit-
ten (.si extension). If you change the test conditions related to the template file
after specifying the template file, the common template file is changed to the
new test conditions.
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If you move the Common Sequence Template file (.si) from the folder containing
the test conditions file or delete it, an error message is displayed when you open a
test conditions file that uses the template file. If this happens, close the test condi-
tions file, move the template file back to the original folder, and open the test condi-
tions file again.

Fig. 7-18 Message that appears when the template file is missing

7.10.4 Assigning Temperature Chambers to Groups

If Num of Chambers is set to 1 or greater on the temperature chamber configuration
screen of the Hardware Configuration Wizard, you can assign the temperature
chambers at the group level.

If Num of Chambers is set to 0, this item is unavailable.

You can assign temperature chambers at the group level on the Test Executive. This
means that all the channels in the group share the same temperature chamber. The
test runs at the same temperature (and same humidity) along a synchronized test
schedule. The Test Execution Panel [START] is used to assign temperature cham-
bers to groups.

Fig. 7-19 Assignment of Temperature Chambers to Groups

If temperature chambers can be used, you can select the temperature chamber num-
ber from the Chamber Synchronization list. The selectable numbers range from 1 to
up to 6. These numbers correspond to the temperature chamber subaddress that the
protocol converter manages. Select Don’t Use if you are not synchronizing a tem-
perature chamber. You cannot select a number of a temperature chamber that is
already assigned to another group. In addition, select the temperature chamber
before assigning the test conditions. The Chamber Synchronization list will appear
dimmed (unavailable) after the test conditions have been assigned.

If the temperature chamber is assigned, all the channels in the group operate in
sync. You cannot select an individual channel to be executed. If you select a single
channel, all the channels in the group that are executable are selected.
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Mixing different test conditions within the group using the Com- 
mon Sequence Template

 

After you assign the temperature chamber number, select the test conditions. The
general rule is to collectively assign the same test conditions to all the channels in
the group when a temperature chamber is synchronized. However, you can excep-
tionally mix different test conditions in the group (and still synchronize a tempera-
ture chamber). In such case, a problem arises in the setup conditions of the
temperature chamber. The setup conditions of a temperature chamber is written on
the charge/discharge sheets in the test conditions. If you mix different test condi-
tions within the same group, this results in a mixture of different setup conditions of
temperature chambers and different test sequences of charge/discharge sheets. How-
ever, such discrepancy is not allowed in temperature chamber synchronization. If
you use a Common Sequence Template file that is managed using the Test Condi-
tion Editor, inconsistencies in the sequence information and temperature chamber
setting information can be avoided. For details on the Common Sequence Template,
see section 7.10.3, “Common Sequence Templete"

 

Requirements for performing tests in synchronization with the 
temperature chambers

 

The Test Executive allows synchronized operation only when all the channels in the
group that is synchronizing the temperature chamber are sequentially consistent. In
summary, the following two conditions are required when assigning test conditions
on the Test Execution Panel [START] for synchronized operation of temperature
chambers.

 

1. The same test conditions or different test conditions that share the
same common template are assigned to all the channels in the
group.

2. The number of cycles that have been completed is the same for all the
channels.

If no discrepancies exist in the test conditions and the completed cycle number, you
can select channels on the Test Execution Panel [START]. However, because the
temperature chamber is synchronized, you cannot select the channels individually
(mix selected and unselected channels).

If you select a single channel, all channels are selected automatically at once.

If you cannot select channels, discrepancies due to reasons described above exist.
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7.10.5 Status Display of Temperature Chambers

If the number of chambers is set to 1 or greater in the Hardware Configuration Wiz-
ard, the Chamber Pane is displayed at the lower right of the screen when the Test
Executive is started. For the setup procedure of temperature chambers, see section
3.2, “Configuring the Hardware."

Fig. 7-20 Chamber Pane

Temperature Chamber
The number of the test chamber assigned in the Hardware Configuration Wizard.

Temperature [˚C]
Temperature monitored in the temperature chamber.

Humidity [%]
Humidity monitored in the temperature chamber.

Status

•Idle
Condition in which the temperature chamber is identified. This status is dis-
played while charging/discharging and resting.

• Setting xx˚C
Status from when the temperature is set until the monitored temperature of the
temperature chamber reaches the setting margin. If the specified temperature is
not reached after the setting timeout elapses, the test is aborted as a setting
error. The time until the monitored temperature reaches the setting margin var-
ies depending on the performance of the temperature chamber.

Chamber Pane
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•Waiting
Waiting status until the DUT warms up to the specified temperature with the
temperature chambers stable at the specified temperature. After the wait time
elapses, charge/discharge operation starts.

•I/O communication error
Status in which communication cannot be performed with the temperature
chamber. See section 6.2.4, “If the Test Executive Cannot Identify Temperature
Chambers."

Timer
Counts down from the specified time while it is in setting or waiting status.
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7.10.6 Behavior When Alarms Occur during Synchronized
Operation with Temperature Chambers

When an alarm occurs on a channel during synchronized operation with tempera-
ture chambers, the test on the channel is automatically aborted on the charge/dis-
charge power unit. You can preset how the test is to proceed in such cases for other
channels in the same group.

Choose Options in the Tools menu to display the Options dialog box and then click
the Alarm Sync tab. The following three choices are available.

Fig. 7-21 Tools > Options > Alarm Sync

Behaviour

• Other channels stop immediately (default)
If you select this behavior, all the channels in the group stop immediately. This
means that the data of the cycle when the alarm occurred is discarded also on nor-
mal channels. However, if you reset the alarm on the corresponding channel, you
can restart the test on all channels from the beginning of the cycle at which the
alarm occurred.

• Other channels stop at the cycle end
In this case, normal channels do not stop immediately. They automatically stop after
completing the discharge phase of the cycle in the current test. This means that the
data of the cycle at the time the alarm occurred can be retrieved on normal channels.

To restart the test, wait for the normal channels to automatically stop and reset the
alarm on the corresponding channel. Then, increment the cycle number of the chan-
nel on which the alarm occurred by 1. (To adjust the cycle number, right-click on
the Channel Pane and then choose Increment Cycle Number +1 from the shortcut
menu.) This action is required because the channel on which the alarm occurred
could not complete the test cycle and is 1 cycle behind other channels. After adjust-
ing the cycle, the test can be restarted (because the cycle numbers on all channels
match).

Note that in this case, the channel on which the alarm occurred will have one cycle
of data missing. The test restarts from the next cycle number after the cycle on
which the alarm occurred.

• Abandon the ALARM CHANNEL, and other channels continues tests
If you select this behavior, normal channels continue the test without stopping. This
means that the data after the alarm occurrence is not retrieved on the channel on
which the alarm occurred.
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7.11 Impedance Measurement

The Test Executive enables you to measure the impedance of the battery under test
using the impedance measurement unit that is connected to the controller. A single
impedance measurement unit can be connected to each controller. When using two
controllers, connect a total of two impedance measurement units. 

Configuration related to impedance measurement units is set using the Hardware
Configuration Wizard. If you choose Hardware Configuration from the Tools
menu of the Test Executive, you can only check the configuration.

Impedance Measurement Operation

Impedance measurement is performed immediately after charge, immediately after
charge rest, immediately after discharge, immediately after discharge rest, or com-
bination of these points according to the test conditions.

The impedance measurement unit can only measure the impedance one channel at a
time. However, all the channels belonging to the same controller share the same
impedance measurement unit. Therefore, the Test Executive performs impedance
measurement on a first-come-first-serve basis. For example, if multiple channels
attempt to move to the impedance measurement process approximately at the same
time, the earliest channel is processed first while others are forced to wait until the
measurement on the earlier channel is finished. As a result, the impedance measure-
ment may be delayed by up to tens of seconds depending on the waiting condition.
(In principle, the measurement must be performed immediately after charge, dis-
charge, or rest.)

The Test Executive holds the channels whose impedance measurement has not been
finished from moving to the next process. However, this applies only to impedance
measurements performed immediately after charge rest (followed by discharge) or
immediately after discharge rest (followed by charge of a new cycle). For measure-
ments immediately after charge or immediately after discharge (followed by rest),
the phase moves to rest even if the impedance measurement has not been per-
formed. This is because the PFX2000 system hardware automatically processes the
transition, and the Test Executive has no control over it.

The impedance measurement is performed only at the timing (immediately after
charge, immediately after charge rest, immediately after discharge, or immediately
after discharge rest) specified in the test conditions. However, if the impedance mea-
surement unit is not connected to the controller to which the channel belongs, the
setting is ignored and the process moves on without making the impedance mea-
surement.

The measured impedance values cannot be monitored in realtime (while the test is
in progress) on the Test Executive. The values are displayed on the ChargeResults
or DischargeResults page on the Graph Result Pane after the completion of the
charge or discharge phase. You can also view the values by analyzing the results
using the Graph Viewer.
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7.12 Screen and Other Functions

7.12.1 Controller/Group Pane

There are two view modes available on the Test Executive: Controller View Mode
and Group View Mode. To switch the display mode, click the Controller tab or
Group tab at the bottom section of the Controller/Group Pane on the left side of the
screen.

Controller View Mode classifies the display by the controller units that are con-
nected to the PC. When you click the control unit from the controller tree view, the
Channel Pane on the right shows only the channels that are connected to the corre-
sponding control unit.

Group View Mode classifies the display by groups irrespective of the connection
status of control units. When you click a group name from the group tree view, the
Channel Pane on the right shows only the channels that are bound to the corre-
sponding group.

7.12.2 Channel Pane

Fig. 7-22 Channel Pane

About the icon display

An icon indicating the channel status is displayed at the left of each channel display.
Table 7-3 shows the icon types.

Table 7-3 Icon Display

Icon Display Name Description

None
The channel is not recognized by the controller. This status is not 
allowed for operating the system normally.

OFF The internal power supply of the channel is OFF.

IDLE
The internal power supply of the channel is ON, and the channel is in 
the monitor loop.

RUN The test is running.

END The test process is finished.

ALM Alarm is occurring.
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Channel Pane screen configuration

The current selected control unit (When Controller View Mode) or group (When
Group View Mode) is displayed at the top section on the left.

The displayed information of each channel is as follows:

You can show or hide some of these items as necessary. There are items that you
cannot hide.

Name This is the name of the channel. Right-clicking the item shows a shortcut 
menu that you can use to add/delete channels, bind the channel to a group, and 
change the individual connection status.

Status Displays the status of the channel. Normally, the status is indicated by a num-
ber. However, you can display a mnemonic of the status on the tool tip by 
placing the cursor over the item.

Operation Displays information concerning the electrical operation currently in progress 
(such as charging). Normally, the operation is indicated by a number. How-
ever, you can display a mnemonic of the operation on the tool tip by placing 
the cursor over the item.

Impedance The word “Measuring” appears while the impedance measurement unit is 
making a measurement on the corresponding channel. Otherwise, nothing is 
displayed.

[h:min:s] Indicates the lapsed time since the test phase was started. During charging, 
this is the time elapsed since charging was started; during discharging, this is 
the time elapsed since discharging was started. The lapsed time includes the 
rest section. The time is not reset when charging/discharging moves to rest. 
Note that this is not the integrated lapsed time since the start of the first cycle.

Cycle Displays the current cycle number, if the test is in execution (RUN icon). Oth-
erwise, the number of the cycle has been completed is displayed. If the test is 
in execution and the number is indicated in parentheses, this indicates predis-
charging. For example, predischarging for cycle number 10 is indicated as 
(10). Initial predischarging is indicated as (1). If the entire process has been 
completed or if you terminate the test, the cycle number is enclosed in brack-
ets and END appears to the left. For example, END[25] indicates that all 25 
cycles of the process have been completed or that you terminated the process 
that is longer than 25 cycles at 25 cycles.

[mAh] Displays the current measured capacity.

[Wh] Displays the current measured wattage.

[A] Displays the current measured current.

[V] Displays the current measured voltage.

High[V] Displays the measured value at the HIGH point of voltage measurement. Dis-
plays the voltage at the HIGH measurement point during pulse charging and 
the voltage at the measurement point (HIGH, 1 to 8) that was specified in the 
test conditions during CC-Pulse discharging. For other modes of discharging, 
“---” is displayed.

Low[V] Displays the measured value at the LOW point of voltage measurement. Dis-
plays the voltage at the LOW measurement point during pulse charging and 
the voltage at the measurement point (LOW, 1 to 8) that was specified in the 
test conditions during CC-Pulse discharging. For other types of discharging, 
“---” is displayed.

[˚C] Displays the current measured battery temperature.
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7.12.3 Graph Result Pane

The lower right (or middle) section of the screen is the Graph Result Pane. The
Graph Result Pane shows the realtime graph, the test conditions, and the summary
of test results for the channel that is selected in the Channel Pane. You can switch
the display as necessary using the Condition, ChargeGraph, DischargeGraph,
ChargeResults, and DischargeResults tabs. The top section of the Graph Result
Pane always shows the name of the channel selected in the Channel Pane regardless
of the tab that is selected.

Condition page
This page shows a summary of the test conditions. The test conditions consist of 15
types of sequence sheets and a predischarge sheet dedicated for initial charging.
However, this page displays only the information of the sheet that is used in the cur-
rent cycle in progress. The number of the sheet that is actually used is indicated by
Sheet No at the top section. For details on each item, see the description of the Test
Condition Editor.

Fig. 7-23 Condition Page

ChargeGraph/DischargeGraph page
This page shows a realtime graph during charging or Discharging. The voltage and
current are displayed. Scaling is done automatically. You can change the drawing
style such as the color and line type of graphs and the number of divisions within
the scale by choosing Options from the Tools menu and then selecting the Drawing
tab.

Fig. 7-24 ChargeGraph Page
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ChargeResults/DischargeResults page
Summary of the charge results and discharge results is displayed.

Fig. 7-25 ChargeResults Page

7.12.4 Properties Display

You can display properties of the controllers, groups, and channels on the Test
Executive. The properties display contains detailed information of each item and
various functions that you cannot control from other screens.

Because the properties sheets are modeless dialog boxes, you can operate the main
screens of the Test Executive and menus while they are open. Normally, when you
click another section on the Test Executive screen while the properties sheets are
open, the sheets close immediately. However, you can leave them open by pressing
in the pin button at the upper right corner of the dialog boxes.

Controller properties display

Fig. 7-26 Controller Properties

To display the controller properties, right-click on the Controller/Group Pane or
choose Properties from the Controller menu in Controller View Mode (select the
Controller tab on the Controller/Group Pane). The properties sheet displays the
model name, serial number, CPU version, LON version (1st and 2nd internal sys-

Pressing in the pin
button keeps the
properties sheet open.
BPC2000 Executing Tests  7-29



tems), and the connection status (plugged or unplugged) of the current identified
control unit. If the status indicates unplugged, the controller is not identified prop-
erly. Click the controller name and click Plug Controller to reconnect it.

If you are using an impedance unit, its information is also displayed. To disconnect
and reconnect the impedance unit, click Plug Impedance.

Group properties display

To display the group properties, right-click
on the Controller/Group Pane or choose
Properties from the Group menu in
Group View Mode (select the Group tab on
the Controller/Group Pane). The properties
sheet displays the name and temperature
chamber information of the current identi-
fied group.

Channel properties display

The channel properties display consists of three properties sheets that you can
switch using tabs.

Info page

Displays the details of the charge/discharge module.

The Module section displays the model name, CPU version, LON version, and
option ID. The option ID is normally 1.

The Channel section displays the name
assigned to the channel and the position
of the connection (instrument ID and
node number).

The System section displays the settings
of DUT check, auto fine, and moving
average. These items are set as a part of
the test conditions. However, during test
execution, the items are set on the actual
hardware when the test conditions are
assigned (when entering the monitor
loop). Therefore, these items are dis-
played only on channels that are display-
ing the IDLE or RUN icon. For all other
cases, blank is displayed.

Fig. 7-27 Group Properties

Fig. 7-28 Channel Properties 
> Info example
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Protections page

This page is used to set the hardware overcharge protection (H OVP) and overdis-
charge protection (H UVP).

■ On the PFX2011 Charge/Discharge Power Supply Unit

To set the hardware protection func-
tions, turn the H OVP and H UVP
variable resistors on front panel of
Charge/Discharge Power Supply
Unit for adjustments. The specified
values are displayed in the Actual
Setting boxes. In addition, by using
Assist Mode, you can check whether
the specified value is within the
appropriate range without looking at
the display.

Target
Enter the voltage values you wish to assign for H OVP and H UVP. These values are
used as a reference for judging whether the value specified on the charge/discharge
power supply unit is within the appropriate range. The judgment result is displayed
on a bar graph and the panel LED of the charge/discharge power supply unit (when
in Assist Mode).

The entered values become new references by clicking the Set button.

Actual Setting
Displays the actual H OVP and H UVP voltage values assigned to the charge/dis-
charge power supply unit. The bar graph on the right indicates whether the actual
value is appropriate with respect to the target. If the bar graph is at the center, the
setting is appropriate with respect to the target.

Auto Refresh
If you select the check box, the Actual Setting display is refreshed at approximately
0.5 s intervals.

Assist Mode
When this mode is enabled, the LEDs on the charge/discharge power supply unit are
used to indicate whether the actual value is appropriate with respect to the target.
This mode is useful when the PC display is far away from the charge/discharge
power supply unit.

When the check box is selected, the front panel LEDs on the charge/discharge
power supply unit function as indicated in Table 7-4.

Fig. 7-29 Channel Proper-
ties > Protections
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Table 7-4 Functionality of the LED in Assist Mode

If you clear the Assist Mode checkbox, you can escape from assist mode. Assist
mode is also disabled when you close the properties sheet, open a properties sheet
of another channel, or execute the test on the channel in assist mode.

• After entering a voltage in the Target box, be sure to click the Set button. The
value is transmitted to the charge/discharge power supply unit when the button is
clicked.

• The indicators will work properly only if appropriate values are entered in Target
boxes.

■ On the PFX2021 Charge/Discharge Power Supply Unit

The setting of the hardware protection functions on this charge/discharge power
supply unit is automatic. When you enter the desired voltages for H OVP and H
UVP in the Target boxes, the internal variable resistors are automatically adjusted.

Fig. 7-30 Channel Properties > Protections

Target
Enter the desired voltages for H OVP and H UVP and click the Set button. The pro-
tection functions are automatically adjusted internally on the charge/discharge
power supply unit.

Auto Refresh
If you select the check box, the Actual Setting display is refreshed at approximately
0.5 s intervals.

LED Description

POWER/STANDBY
Blinks in orange and indicates that the LED is in assist 
mode.

CHG/DISCH/REST
Lights in green when the hardware OVP setting is within 
the appropriate range.

CC/CV/CP
Lights in green when the hardware UVP setting is within 
the appropriate range.

ALARM/WARNING Same function as in the normal mode.

NOTE

Not used.
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Assist Mode
Assist Mode is not used.

• After entering a voltage in the Target box, be sure to click the Set button. The
value is transmitted to the charge/discharge power supply unit when the button is
clicked.

• If the Assist Mode check box is selected even for the PFX2021, the panel LED
display will change to Assist Mode.

Axes page 

This page is used to set the axes of
the realtime graph display (charge
graph and discharge graph on the
Graph Result Pane).

7.12.5 Display Options

You can change the display settings for the Test Executive using the dialog box that
opens when you choose Options from the Tools menu. The Options dialog box con-
sists of five pages.

Drawing page

This page is used to set the realtime
graph drawing options

NOTE

Fig. 7-31 Channel Properties > Axes

Fig. 7-32 Tools > Options > Drawing
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Monitor page

This page is used to set the dis-
played items and the unit used on
the Channel Pane.

You can select code or mnemonic
for the State, Operation, and Imped-
ance displays. Select Mnemonic to
use easy-to-understand displays
such as Charge and CC.

If you select the Reset Column
Width checkbox, the column width
of the items such as names and sta-
tus displayed on the Channel Pane
is reset to its default value.

• The resistance unit setting is applied only to the CR charge/discharge value.

• The battery impedance is always displayed in [Ω].

Warnings page

This page is used to set the warning
style.

If you select the Show execution
prompt messages checkbox, a
confirmation message is displayed
when you click the OK button on
the Test Execution Panel.

If you set the System Resource
Warnings, the test automatically
stops when the free disk space is
less than equal to the specified
value.

Alarm Sync page

For details on the Alarm Sync page, see section 7.10.6, “Behavior When Alarms
Occur during Synchronized Operation with Temperature Chambers.”

Fig. 7-33 Tools > Options > Monitor

NOTE

Fig. 7-34 Tools > Options > Warnings
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Text generator page

Sets the format of the text that is gen- 
erated as test data.

If you select the 

 

Generate Text Files

 

checkbox, a test data file in text for-
mat is generated in addition to the test
data file in binary format used by the
Graph Viewer program.

The data file is saved only if the

 

Record

 

 check box is selected in Test
Conditions > Sequence in the Test
Condition Editor. See section 5.3.8,
“Sequence."

This option can be used when you
wish to perform your own data analy-
sis.

If you wish to use a tab as a separator,
enter “\t”.

Do not use the same character for the decimal point and the separator.

Normally, use the default values that depend on the regional setting of Windows.

 

Fig. 7-35 Tools > Options > 
Text Generator
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88

Chapter 8 Analyzing Test 

Results

This chapter describes the Graph Viewer, a tool for analyzing test results.
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8.1 Graph Viewer

 

The Graph Viewer is a program used to display graphs of the test data created by the
Test Executive on the screen and print the graphs. In addition to the test data graphs,
the Graph Viewer displays numerical values of the test data, computed values
derived from the test data such as energy, test conditions, and other information.
This enables you to analyze the data comprehensively.

The Graph Viewer creates the following two types of graphs. These two graphs can
be created arbitrary for the DUT (battery) that is included in the selected project.
You can also superimpose the battery graphs on top of each other, if the graphs are
of the same type.

 

Cycle life characteristics (Life) graph

 

This graph indicates the changes in the capacity of the DUT (battery) with respect
to the number (cycle) of charge/discharge tests. A graph is drawn using the test data
from the first cycle to the last cycle for a given battery.

 

Charge/Discharge characteristics (C/D) graph

 

This graph indicates the charge/discharge characteristics of the battery over an arbi-
trary cycle of the charge/discharge test (cycle) performed on a given battery. A
graph is drawn using the test data of the selected cycle.

 

Starting the Graph Viewer

 

To start the Graph Viewer, double-click the shortcut icon of the Graph Viewer pro-
gram from the Windows desktop folder or program folder.

 

Fig.8-1 Graph Viewer Window

Graph Pane

Data Table Pane

Analysis Pane

Document WindowTree Window

C/D Pane
Life Pane
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Below is the construction of the Graph Viewer screen.

 Tree window  

The window displayed on the left side of the application screen used to switch tabs.
This window is always displayed while the Graph Viewer is running regardless of
whether graph documents are present.

Clicking the C/D tab shows the C/D Pane, and a list of C/D graph data (charge/dis-
charge data) that can be displayed is shown.

Clicking the Life tab shows the Life Pane, and a list of Life graph data (life charac-
teristics data) that can be displayed is shown.

The ones shown in the list are not all the test data that can be displayed. The ones
shown here are only those that are assumed to be frequently used (the folder speci-
fied in advance).

 

Document Window

 

A Document Window opens each time a graph document of cycle life characteris-
tics (Life) or charge/discharge characteristics (C/D) is created. Since graphs are not
displayed immediately after the Graph Viewer is started, the Document Window is
not displayed. 

The screen construction is the same for C/D and Life graphs. It is divided into the
Graph Pane at the upper left, the Data Table Pane at the upper right, and the Analy-
sis Pane at the bottom.

The Graph Pane shows the cycle life characteristics (Life) or charge/discharge (C/
D) graph. The Data Table Pane shows test information, test conditions, test data, and
test results. The Analysis Pane shows the analysis data determined by computing the
test data using sequence numbers. The DUT name is displayed along with the
sequence number for easy distinction of batteries.

 

Fig. 8-2 Example of DUT names displayed along with the sequence 
numbers

Sequence number display
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8.2 Displaying Graphs

 

There are three methods for displaying the charge/discharge characteristics (C/D)
graph or the cycle life characteristics (Life) graph or superimposing the same type
of graphs.

 

• Using the Select Graph dialog box
• Using the tree window
• Using Windows Explorer

 

Folder containing the graph data file you wish to display

 

To display graphs, you must select the folder containing the graph data file you wish
to display. The hierarchy of the selected folder varies between C/D graphs and Life
graphs.

The folder that should be selected for each type of graph is explained using Fig. 8-3.

There is a folder named cccv (test conditions) that contains the test results obtained
by using a test conditions file named cccv in a group folder named bpc2000(cccv).

Within the cccv folder are folders [CH_n_nnn] for 10 channels. In the channel 1
folder [CH_1_001] are C/D graph data and Life graph data.

For each channel, a C/D graph data file is created for each test cycle that is per-
formed as well as 1 charge data file and 1 discharge data file for the Life graph. For
details on the folders and files that are created, see appendix section A.4, “Folders
and Files.”

For example, to display the C/D graph corresponding to the second cycle of channel
1, you select the [CH_1_001] folder. To display the Life graph of channel 1, you
select the cccv (test conditions) folder that is one folder higher than channel 1.

 

Fig. 8-3 Folder Selected When Displaying Graphs

C/D graph files

Life graph files

To display Life 
graphs, select the test 
conditions folder.

To display Life 
graphs, select the test 
conditions folder.
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8.2.1 Methods of Displaying Graphs

 

■

 

Using the Select Graph dialog box

 

If the Show Folder check box is selected, the files are displayed using full path in
the Cycle to Show and Channels to Show boxes. If the check box is not selected,
BPCG files are displayed for the C/D graph and the channel folder names are dis-
played for the Life graph.

 

1. From the 

 

File

 

 menu, point to 

 

New

 

 and then choose 

 

C/D Graph

 

 or 

 

Life
Graph

 

.

 

The Select Graph dialog box appears.

 

Fig. 8-4 Select Graph Dialog Box

2. Click the [...] button of Folder To Search, and select the folder contain-
ing the graph you wish to display.

 

For a description of the folder you should select, see “Folder containing the
graph data file you wish to display” in the previous section.

For C/D graphs, a list of BPCG files is displayed in the Cycle box of the dialog
box.

For Life graphs, a list of channel folder names is displayed in the Channel box
of the dialog box (not a list of BPCL files).

 

3. Select the items you need from the Cycle box or Channel box, and click

 

Add>>

 

, 

 

Insert Before>>

 

, or 

 

Insert After>>

 

.

 

The selected items moves to the Cycle to Show or Channel to Show box. The
graph of the items in this box will be displayed.

Click 

 

Add>>

 

 to add the item at bottom.

If you click 

 

Insert Before>>

 

 or 

 

Insert After>> after selecting an item in the
Cycle to Show or Channel to Show box, the item is inserted before or after the
selected item.

If you select items in the right box and click Delete, the items are removed
from being displayed.

4. Click OK.

C/D Life
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■ Using the tree window

1. From the tree window on the left side of the Graph Viewer screen,
select the C/D Pain or the Life Pain.

2. Right-click the top section of the tree display.

A shortcut menu appears.

3. From the shortcut menu, choose Change Folder.
A dialog box used to select the folder appears.

Fig. 8-5 Browse For Folder Dialog Box

4. Select the folder containing the graph you wish to display.

For a description of the folder you should select, see “Folder containing the
graph data file you wish to display” in the previous section.

For C/D graphs, a list of BPCG files in the selected folder is displayed in the
tree window.

For Life graphs, a list of channel folder names in the selected folder is dis-
played (not a list of BPCL files).

5. Select the graphs you wish to display from the tree display.

6. Drag and drop the objects outside the document window (dark gray
area)

■ Using Windows Explorer

1. Open Windows Explorer.

2. Select one or multiple graph data files you wish to display.

For C/D graphs, select files with .BPCG extension.

For Life graphs, select files with .BPCL extension. You can select either
Life_C.BPCL or Life_D.BPCL.

3. Drag and drop the objects outside the document window (dark gray
area)

If a single file is selected, one graph is displayed; if multiple files are selected,
multiple graphs are displayed superimposed.
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8.2.2 Superimposing Graphs

When a new C/D graph or Life graph is displayed, you can display the graph as an
independent graph or as an superimposed graph. On graphs that are already dis-
played, you can superimpose more graphs or remove unneeded superimposed data.

• You cannot superimpose C/D graphs and Life graphs together.
You can use drag and drop to increase the data to be superimposed, but you must
use the Select Graph dialog box when removing the superimposed data.

■ Using the Select Graph dialog box

1. Activate the graph document you wish to superimpose.

2. From the Data menu, choose Select Graph.

The Select Graph dialog box (the same dialog box when you open a new
graph) appears.

3. In the dialog box, add the graphs to be superimposed or remove the
superimposed graphs, and click OK.

■ Using the tree window

1. Activate the graph document you wish to superimpose.

2. From the tree window, select the Graph Pane of the same type (C/D or
Life).

3. Drag and drop the graphs you need from the list onto the document
window that is already opened.

■ Using Windows Explorer

1. Activate the graph document you wish to superimpose.

2. Open Windows Explorer.

3. From Explorer, select the graph data files or folder you wish to display.

For C/D graphs, select BPCG files.

For Life graphs, select BPCL files or a channel folder.

4. Drag and drop the selected items onto the document window that is
already opened.

■ Using Graph Explorer

Only an English version of Graph Explorer is available. The program can handle
Japanese file names.

1. Choose Graph Explorer from the Option menu.

Graph Explorer starts.

2. Search the test data by using the file extension, instrument ID, channel
number, and cycle number as keywords.

3. Drag and drop the search result onto the Graph Viewer.

NOTE
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8.2.3 Operations of the C/D graph

Graph type
You can select one of the following three types of graphs by choosing Graph from
the View menu.
• Charge/Discharge graph
• Charge graph
• Discharge graph

The charge graph displays only the charge characteristics; discharge graph displays
only the discharge characteristics.

The charge/discharge graph displays the charge characteristics followed by the dis-
charge characteristics as shown in Fig. 8-6.

Fig. 8-6 Charge/Discharge Graph

X axis and Y axis
You can select the X axis display from time, capacity, and watthour. Choose X Axis
from the View menu.

You can select the Y axis display from voltage, current, capacity, and temperature.
Choose Y Axis from the View menu.

Scale
Choose Scale from the View menu to set the minimum, maximum, and step for each
axis.

Enter values for minimum and maximum; drag the slide bar on the right to set the
step.

The scale setting can be saved. Enter the name in the Save To box and click Save.
Once saved, you will be able to select the name of the saved setting from the Load
From box. Click Load to load the setting.

To delete the settings that you saved, select the name to be deleted in the Load From
box, and click Delete.

The default setting to be loaded is Auto Scale. Auto Scale automatically sets the
scale to the best-suited setting for the data. To change the default setting to be
loaded, select the setting you wish to make the default from the Load From box
and click Load.

[V][A]

 [h]

Charge Discharge

Voltage

Current
8-8  Analyzing Test Results BPC2000



Fig. 8-7 Scale Setting of C/D Graphs

Drawing style
Choose Drawing Style from the Options menu to specify the pen width and color
for each line. You can also show or hide the lines.

The No. (line number) setting is applied when graphs are superimposed. Select the
desired line number to set the line width and pen color. The line number corre-
sponds to the No item shown on the Analysis Pane.

If you select the Show Rest Data checkbox, the data that is measured during rest is
displayed on the graph.

Fig. 8-8 Drawing Style of C/D Graphs

If more than 100 graphs are superimposed, the settings are applied again from line
number 1. For example, the settings (pen width and color) of graph number 101 are
the same as those of graph number 1.
BPC2000 Analyzing Test Results  8-9



Setting analysis data
Choose Set Analysis Data from the Data menu to display the Analysis Data dialog
box.

On the Analysis Input Data page, you can change the information used to calculate
the voltage, weight energy density, and volume energy density that are displayed on
the Analysis Pane. By default, the test conditions information you entered on the
Test Condition Editor is used.

Fig. 8-9 Changing of the Calculation Reference

On the Draw Style page, you can set the charge capacity calculation voltage and dis-
charge capacity calculation voltage to be displayed on the graph. Selecting the
Show Line checkbox turns ON the graph. You can also specify the line width and
color.

Fig. 8-10 Display Setting of the Capacity Calculation Voltage

Changing the drawing unit
Choose Drawing Unit from the Options menu to change the unit of C/D graphs.

Fig. 8-11 Changing of the Unit
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8.2.4 Operation of the Life graph

Graph type
You can select one of the following three types of graphs by choosing Graph from
the View menu.
• Capacity/Impedance graph
• Capacity graph
• Impedance graph

The capacity graph consists of two lines, one for charge capacity and the other for
discharge capacity.

The impedance graph consists of lines for the following four points: Immediately
after charge is finished, immediately after charge rest is finished, immediately after
discharge is finished, and immediately after discharge rest is finished. These four
lines are drawn for each of the four display items, R, JX, Z, and θ. The four items,
R, JX, Z, and θ can be shown or hidden. Thus, if all items are shown, 16 lines are
displayed. Fig. 8-12 shows the case when you select capacity/impedance graph, and
only R is displayed.

Fig. 8-12 Capacity/Impedance Graph

In the Graph Viewer, the displayed unit for measured impedance is [mΩ].

X axis and Y axis
The X axis shows the cycle. Choose X Axis from the View menu bar to select linear
display or logarithmic display.

The Y axis shows the capacity. Choose Y Axis from the View menu bar to select
capacity value or capacity ratio.

If you select capacity ratio, the change in the capacity is displayed with respect to
the specified cycle. To specify the reference cycle, choose Capacity R

atio Reference Cycle from the Data menu.

Fig. 8-13 Setting Capacity Ratio Reference Cycle

[mAh] 

R Charge/Discharge capacity

Charge

Discharge

Charge finished

Charge rest finished

Discharge finished

Discharge rest finished

[mΩ]
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Scale
Choose Scale from the View menu to set the minimum, maximum, and step for each axis.

Enter values for minimum and maximum; drag the slide bar on the right to set the
step.

The scale setting can be saved. Enter the name in the Save To box and click Save.
Once saved, you will be able to select the name of the saved setting from the Load
From box. Click Load to load the setting.

To delete the settings that you saved, select the name to be deleted in the Load
From box, and click Delete.

The default setting to be loaded is Auto Scale. Auto Scale automatically sets the
scale to the best-suited setting for the data. To change the default setting to be
loaded, select the setting you wish to make the default from the Load From box
and click Load.

Fig. 8-14 Scale Setting of Life Graphs

Drawing style
Choose Drawing Style from the Options menu to specify the pen width and color
for each line. You can also show or hide the lines.

If you clear the Show box, the corresponding will not be displayed.

The No. (line number) setting is applied when graphs are superimposed. Select the
desired line number to set the line width and pen color. The line number corre-
sponds to the No item shown on the Analysis Pane.

You cannot show or hide line numbers individually. The Show box applies to all line
numbers.
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Fig. 8-15 Drawing Style of Life Graphs

8.2.5 Setting Comments on Graphs

You can enter comments on the graph. Select the graph on which you wish to enter
a comment and choose Set Comments from the Data menu.

The text that you enter in the Set Comments dialog box appears on the graph. This
comment also appears when you print the graph. See Fig. 8-18.

Fig. 8-16 Setting of Comments Fig. 8-17 Comment Entry Example

Comment
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8.3 Printing Graphs

To print graphs, select the window containing the graph you wish to print and then
choose Print from the File menu. If you wish the check the printed image on the
screen beforehand, choose Print Preview from the File menu.

Fig. 8-18 shows a printed image of C/D graphs. If superimposed graphs are printed,
data like the one shown in Fig. 8-18 page 2/2 that is displayed on the Analysis Pane
are also printed.

Fig. 8-18 Print Image of C/D Graphs

Setting print headers
You can print a header at the top left of the page as shown in Fig. 8-18. Select the
desired graph and choose Set Print Header from the Data menu.

The text that you enter in the Printer Header dialog box appears on the printed
page.

Fig. 8-19 Entry of the Print Header

Print header Print headerComment

1/2 2/2
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Switching between color printing and black and white printing
The graphs can be printed in color.

Choose Colour Printing from the File menu to switch between color printing and
black and white printing. If the printer icon before the Colour Printing command
appears pressed in, color printing is possible.

Fig. 8-20 Switching between Color Printing and Black and White Printing

8.4 Saving Graphs

■ Saving graphs

You can save graphs to a file by assigning a name.

To save graphs, select the window containing the graph you wish to save and then
choose Save from the File menu. A Save dialog box appears. Enter the file name.

To open a saved graph, choose Open from the File menu. An Open dialog box
appears. Enter the file name.

You can also copy the graph image to other documents via the clipboard. To copy
the graph to the clipboard, select the window containing the graph you wish to copy
and then choose Copy Graph from the Edit menu.

■ Saving graphs as text

You can save the graph data in text format (separated by tabs).

To save graphs in text format, select the window containing the graph you wish to
save and then choose Save Text from the File menu. A Save dialog box appears.
Enter the file name.

You can also copy the data on the Data Table Pane to other documents via the clip-
board. To copy the data to the clipboard, select the window containing the graph you
wish to copy and then choose Copy Data from the Edit menu.

Color printing possible when a frame is displayed
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Appendix

The appendix provides explanation of recovery after power failures, alarms, opera-
tion when connections are improper, and folders and files that are created. It also
provides a list of the menus and the range of test condition settings.

A.1 Recovery after Power Failures

This section describes the behavior of the PFX2000 system when a power failure
occurs while using the system.

A.1.1 When a Power Failure Occurs on the Charge/Dis-
charge Power Supply Unit

If a power failure occurs on the charge/discharge power supply unit while the host
PC is running normally, the behavior of the Test Executive varies depending on the
operation status of the charge/discharge power supply unit. The operation status of
the charge/discharge power supply unit is indicated on the Channel Pane using
icons. Here, explanation will be given for each icon display.

If a power failure occurs on a charge/discharge power supply 
unit displaying a RUN icon

1. If a power failure occurs on a channel, the Test Executive will detect a
communication error within approximately 10 s. The icon corresponding
to the channel changes to an I/O icon as shown in Fig. A-1. (This is the
same if the power failure recovers within 10 s.)

2. After the power failure recovers (or after turning on the power), reset the
alarm.
For details on resetting the alarm, see section 7.6, “Resetting Alarms.”

3. After the alarm is reset, the status of the corresponding channel changes
to an IDLE icon.
The cycle number displayed at this point corresponds to the cycle that
was being executed when the power failure was detected.

4. If you restart the test, the test is executed from the start of the cycle that
was being executed when the power failure was detected.
If Perform Startup Predischarge checkbox is selected in the test condi-
tions, the test starts with predischarge.

If a power failure occurs on a charge/discharge power supply 
unit displaying an IDLE icon

1. The icon corresponding to the channel changes to an I/O icon as shown
in Fig. A-1.

2. After the power failure recovers (or after turning on the power), reset the
alarm.
For details on resetting the alarm, see section 7.6, “Resetting Alarms.”
BPC2000 Appendix  A-1



3. After the alarm is reset, the status of the corresponding channel returns
to an IDLE icon.
The cycle number displayed at this point corresponds to the cycle that
was already completed when the power failure was detected. If the test
has not been executed yet, the cycle number is 0.

Fig.A-1 Communication Error

If a power failure occurs on a charge/discharge power supply 
unit displaying an END icon

1. The Test Executive is not monitoring the channel when the channel is in
the END icon status.
After the power failure recovers (or after turning on the power), the status
indication of the channel retains the OFF icon.

2. You can execute the test as in the normal case.

If a power failure occurs on a charge/discharge power supply 
unit displaying an OFF icon

1. The OFF icon status indicates that you can deliberately insert or remove
the unit. Therefore, the Test Executive cannot determine whether the con-
dition in which the power is not supplied to the unit is due to a power fail-
ure or because the unit is removed from the frame.

2. The Test Executive is not monitoring the channel when the channel is in
the OFF icon status.
After the power failure recovers (or after turning on the power), the status
indication of the channel retains the OFF icon.

3. You can execute the test as in the normal case.

• If you execute the test while the unit is not available (power is not supplied), an
error occurs.

A.1.2 When a Power Failure Occurs on the Host PC

If a charge/discharge power supply unit executing a test (RUN 
icon indication) exists when the power failure occurs

1. The unit executing the test continues the test until the phase (charge or
discharge) that was running at the time of the power failure is finished. If
the unit is charging, the test continues until the end of charge rest.

NOTE
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2. If you restart the PC and restart the Test Executive, the Test Executive
stops the operation of all units.
The test in progress on channels is aborted, and the status changes to
the IDLE icon. This is also true if the phase had already been finished
when the Test Executive is started.

3. The test while the PC is down is discarded, because no data is present.
This means that channels showing the IDLE icon had stopped one cycle
before the point when the PC went down.

4. If you restart the test, the test is executed from the start of the next cycle
(cycle that was being executed when the power failure occurred).
If Perform Startup Predischarge checkbox is selected in the test condi-
tions, the test starts with predischarge.

If a charge/discharge power supply unit that is not executing a 
test exists when the power failure occurs

1. All units recover to the status that they were in when the power failure
occurred.

A.1.3 When a Power Failure Occurs on Both the Charge/Dis-
charge Power Supply Unit and PC

1. Immediately after the power to the hardware recovers, all charge/dis-
charge power supply units enter the STANDBY status.

2. When you start the Test Executive, the Test Executive recovers the
charge/discharge power supply units to the status that they were in when
the power failure occurred.

3. The status of the channels that were executing tests when the power fail-
ure occurred becomes IDLE icon. They are stopped one cycle before the
point when the power failure occurred.

A.1.4 When a Power Failure Occurs on the Control Unit
(USB Connection Dropped)

1. The Test Executive detects an USB communication error within approxi-
mately 10 s. All the channels of the corresponding controller change to
the I/O icon. However, unlike the I/O communication error of individual
channels, the controller icon also disappears.

2. Display the properties of the controller that produced the communication
error and reconnect. You do not have to reset alarms on channels individ-
ually.

3. After the alarm is reset, the status of the corresponding channel changes
to an IDLE icon.
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A.2 Alarms

This section describes the alarms and warnings of the PFX2000 Series Charge/Dis-
charge Battery Test System.

A.2.1 Alarm and Warning Concepts

The charge/discharge battery test system must perform unmanned cycle tests stably
and safely for an extended time period. Therefore, this system is equipped with mul-
tiple protection functions that cover all the dangerous conditions that can be
assumed.

There are two types of protection functions.

(1) Those in which the user specifies values according to the DUT and acti-
vate using the specified values as references.

(2) Those that activate using fixed values that are assigned within the system
as references

Protection functions of type (1) require correct understanding and application of
each alarm and warning. In addition, knowing the conditions that activate the pro-
tection functions of type (2) will help in preventing the alarm from occurring.

Alarms and warnings are summarized in Table A-1 to A-3 by type. Please refer to
them for your understanding and correct application of the alarms and warnings.

• If alarms and warnings are not set correctly, problems will occur. The protection
function may fail to trip when abnormal conditions occur (when necessary), and
the DUT may break. Or, the test may be aborted even when there is no abnormal
condition.

NOTE
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TableA-1 Protection Functions That Require the User to Set 
Appropriate Values (Alarms)

Type Description Usage Note

S_OVP

When the DUT voltage is 
greater than or equal to the 
specified voltage, an alarm 
occurs and the output is turned 
OFF.

Since accurate detection is pos-
sible, you usually set the volt-
age relatively close to the cutoff 
voltage or CV voltage for 
charging.

Accurate overvoltage detection 
is possible, because the detec-
tion accuracy is the same as the 
normal voltage measurement 
accuracy. However, the detec-
tion speed is slow at 150 ms 
(maximum).

H_OVP

Set a voltage that is higher than 
S_OVP to prevent erroneous 
operation due to noise and by 
taking the detection accuracy 
(±100 mV) into consideration.

A comparator is used at the 
detection section and the circuit 
is independent from the internal 
microcomputer control. The 
detection speed is fast at 100 μs 
(maximum).

S_UVP

When the DUT voltage is less 
than or equal to the specified 
voltage, an alarm occurs and the 
output is turned OFF.

Since accurate detection is pos-
sible, you usually set the volt-
age relatively close to the cutoff 
voltage for discharging.

Accurate undervoltage detec-
tion is possible, because the 
detection accuracy is the same 
as the normal voltage measure-
ment accuracy. However, the 
detection speed is slow at 150 
ms (maximum).

H_UVP

Set a voltage that is lower than 
S_UVP to prevent erroneous 
operation due to noise and by 
taking the detection accuracy 
(±100 mV) into consideration.

A comparator is used at the 
detection section and the circuit 
is independent from the internal 
microcomputer control. The 
detection speed is fast at 100 μs 
(maximum).

OAH

When the charge or discharge 
capacity exceeds the specified 
capacity value (nominal capac-
ity multiplied by ### %), an 
alarm occurs and the output is 
turned OFF.

This protection operates cor-
rectly only when the nominal 
capacity in Battery Info test 
conditions is specified.

–

OTP

When the DUT temperature 
exceeds the specified tempera-
ture, an alarm occurs and the 
output is turned OFF.

Specify an appropriate value by 
taking the temperature mea-
surement error and ambient 
temperature fluctuation into 
consideration.

If you are not performing tem-
perature measurements 
(includes the case when a ther-
mistor is not connected), dis-
able OTP.

Comm

The difference in the electric 
potential between the output 
cable and voltage sensing wire 
is measured immediately before 
the start of the test. If the differ-
ence is greater than or equal to 
the specified value, an alarm 
occurs.

To enable this alarm, enable the 
DUT connection check function 
in the Module test conditions 
settings.

The difference in the electric 
potential is not measured during 
the test.
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Table A-2 Protection Functions with Fixed Values (Alarms)

Table A-3 Warnings

Type Description Usage Note

OHP

When the temperature of the 
internal circuit continuously 
increases and reaches the pre-
scribed temperature (95 °C to 
100 °C), an alarm occurs and 
the output is turned OFF.

The detection of this alarm is 
always in progress. The user 
does not have to set it.

If OHP trips continuously even 
when no abnormal conditions 
exist in the ambient tempera-
ture, dust filter, and so on, dis-
able it.

S_OCP

If the charge/discharge current 
exceeds the constant current 
preset value, an alarm occurs 
and the output is turned OFF.

The detection of this alarm is 
always in progress. The user 
does not have to set it.

An alarm occurs when a current 
that exceeds the constant cur-
rent preset value by 100 mA is 
detected.

Comm

When the communication 
between the control unit and the 
charge/discharge power supply 
unit is not working properly, an 
alarm occurs.

The detection of this alarm is 
always in progress. The user 
does not have to set it.

Even if an alarm occurs, the test 
continues until the phase cur-
rently in progress (charge or 
discharge) ends.

AC_OFF

If the input line voltage drops or 
a short interruption occurs, an 
alarm occurs and the output is 
turned OFF.

The detection of this alarm is 
always in progress. The user 
does not have to set it. If an 
error is detected and the alarm 
trips, the alarm cannot be reset 
using alarm reset.

An alarm occurs when the input 
line voltage is less than or equal 
to 180 V or when the short 
interruption lasts longer than or 
equal to 50 ms.

CD/B

If constant current or constant 
voltage control does not work 
correctly because the resistance 
in the DUT or output cable is 
large, an alarm occurs and the 
output is turned OFF.

The detection of this alarm is 
always in progress. The user 
does not have to set it.

The CD/B alarm may occur if 
the DUT is not connected or the 
output cable breaks in the mid-
dle of the test.

PS/B

When the internal power supply 
circuit section is abnormal 
(overvoltage or overheat), an 
alarm occurs and the output is 
turned OFF.

The detection of this alarm is 
always in progress. The user 
does not have to set it. If an 
error is detected and the alarm 
trips, the alarm cannot be reset 
using alarm reset.

The alarm is cleared when you 
recycle the power to the frame. 
If an alarm occurs again, stop 
using the unit and request 
repairs.

Type Description Usage Note

Idle (DUT 
Connection 
Warning)

A warning occurs if the differ-
ence in the electric potential 
between the output cable and 
the voltage sensing wire is 
greater than or equal to the pre-
scribed value in idle status.

This warning operates only 
when the DUT connection 
check function is enabled in the 
Module test conditions settings.

You cannot start the test when a 
warning is activated. (Test con-
ditions cannot be assigned.)

Idle (Pro-
tection 
Warning)

A warning occurs when the 
DUT voltage is in the H_OVP 
or H_UVP trip range in idle sta-
tus.

The detection of this warning is 
always in progress. The user 
does not have to set it.

You cannot start the test when a 
warning is activated. (Test con-
ditions cannot be assigned.)
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A.2.2 List of Status Codes

Table A-4 shows a list of codes (or mnemonics) that are displayed under Status on
the Channel Pane of the Test Executive. Codes that are #8000 or above indicate that
an alarm is occurring. Fig. A-2 through Fig. A-4 show the cause of the alarms and
the way to correct them.

Switching between code and mnemonic displays
The status can be displayed using a code (hexadecimal code) or mnemonic. On the
Tools menu of the Test Executive, choose Options and click Monitor.

Select Yes - Code for the State item to display the status using codes; select Yes -
Mnemonic to display using mnemonics.

State status codes

For details on the #0002 and #0003 warnings, see Table A-3.

Table A-4 Status Code of status in the Channel Pane

Status 
Description

Code

 

*1

 

*1.The codes inside the parentheses are for the low range setting.

 

Mnemonic

 

#0000 (#0100) Stand-by Standby status (internal power supply OFF)

#0001 (#0101) Idle Idle status (test execution possible)

#0002 (#0102)
Idle (DUT Con-
nection Warning)

Idle status (test execution not possible/abnormal connection)

#0003 (#0103)
Idle (Protection 
Warning)

Idle status (test execution not possible/protective function acti-
vated)

#0004 (#0104) H Protection Hardware OVP/UVP setup mode

#000A (#010A) Charge Charging

#000B (#010B) Charge Rest Charge rest

#000C (#010C) Charge SYNC Charge rest (synchronization)

#000D (#010D) Charge End Charge finished

#000E (#010E) Discharge Discharging

#000F (#010F) Discharge Rest Discharge rest

#0010 (#0110) Discharge SYNC Discharge rest (synchronization)

#0011 (#0111) Discharge End Discharge finished
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Alarm status codes

 

Alarms are displayed by converging 16-bit data to hexadecimal code.

The displayed error code is the logical sum of the bits.

When displaying the status using mnemonics, Low Range (bit 8) and ALM (bit 15)
are not displayed.

For details on alarms, see Table A-1 and Table A-2.

 

Table A-5 Status codes of alarms in the Channel Pane

 

Example) If status code #9300 is displayed

This indicates that CD/B (1000) and H_OVP (200) alarms (8000) occurred simulta-
neously while operating in low range (100).

Status 
Description

Bit
Bit 

Weight
Mnemonic

 

0 1 Conn Abnormal connection

1 2 S_OVP Software overvoltage protection

2 4 S_UVP Software undervoltage protection

3 8 S_OCP Overcurrent protection

4 10 OTP Overtemperature protection

5 20 OAH Overcharge/Overdischarge protection

6 40 Comm Communication error detected

7 80 AC_OFF Abnormal AC line detected

8 100 Low Range Set when the current range is set to low.

9 200 H_OVP Hardware overvoltage protection

10 400 H_UVP Hardware undervoltage protection

11 800 ETC Reserved

12 1000 CD/B Abnormal internal charge/discharge unit (electronic load section)

13 2000 PS/B Abnormal internal charge/discharge unit (power supply section)

14 4000 OHP Overheat protection

15 8000 ALM Alarm occurrence
A-8  Appendix BPC2000



  

A.2.3 Cause of Alarms and Their Correction

 

Fig. A-2

   

PS/B

#A000

CD/B

#9000

H_UVP

#8400

OHP

#C000

Alarm
Code

Cause

The heat sink temperature of the
internal electronic load exceeded
approximately 95 °C.
Leave the system in a stopped status
(status other than RUN) until the fan
control drops to SLOW.

The heat sink temperature of the
internal bias power supply exceeded
approximately 100 °C.
Leave the system in a stopped status
(status other than RUN) until the fan
control drops to SLOW.

The overvoltage protection circuit of
the internal bias power supply was
activated.

The impedance of the DUT (battery)
has become extremely large
preventing current from flowing
through the internal electronic load
section.

The hardware undervoltage protection
of the load was activated.

Maximum rated operation was
performed in an environment with an
ambient temperature of 40 °C or greater.

Malfunction of the fan or the fan
control circuit.

Malfunction of the internal circuit
(power loss control).

Malfunction of the internal bias power
supply.

Blown output fuse in the
charge/discharge power supply unit.

Disconnection of the current wire, poor
contact to the battery holder, or open
circuit at the point of connection with
the DUT (battery).

The voltage drop caused by resistance
such as the current wire resistance and
the contact resistance of the battery
holder is extremely large.
(Approx. 8 V or more)

The DUT (battery) voltage dropped
below the H_UVP setting.

Corrective Action

Use the system in the operating
temperature range (0 °C to 40 °C).

Contact your Kikusui distributor or agent.

Check the connection of the current
wire, battery holder, and DUT (battery.)

Check that the diameter and length of
the current wire, the contact resistance
of the battery holder, and other
components are appropriate.

Correct the problem in the DUT
(battery).
If a resistor is used as a load, check
that the voltage drop during discharge
does not fall below the H_UVP setting.

Set the H_UVP setting to an
appropriate value.
The setting is changed using the
variable resistor on the front of the
charge/discharge power supply unit.
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Fig. A-3

H_OVP

#8200

AC_OFF

#8080

Comm

#8040

OAH

#8020

OTP

#8010

Alarm
Code

Cause Corrective Action

The hardware overvoltage protection
of the load was activated.

A power disruption was detected.

A communication error occurred
between the control unit and the
charge/discharge power supply unit.

The capacity of charge to the DUT or
discharge from the DUT exceeded
the number of factors of the nominal
capacity specified. (100 % to 1000 %
of the nominal voltage)

The temperature measurement result
exceeded the OTP temperature setting.

An irregular test such as overcharge
and overdischarge was performed.

Zero-crossing detection of the AC
input stopped.

The DUT (battery) voltage exceeded
the H_OVP setting.

Malfunction in the charge/discharge
power supply unit or the controller.

A disconnection or short circuit in the
TP-BUS connection or a connector
drop out.

A problem occurred at the DUT
(battery), and the end condition was
not reached even when the number
of factors of the nominal capacity
that was specified was exceeded.

Current continued to flow without
moving to rest due to an inappropriate
end condition.
The nominal capacity was set lower
than the actual capacity.

The DUT is actually releasing heat.
Or, an irregular test such as
overcharge and overdischarge was
performed.

Correct temperature cannot be
measured, because the thermistor is
not connected or is short-circuited.

Correct the problem in the DUT
(battery).
If a resistor is used as a load, check
that the voltage drop during charge
does not exceed the H_OVP setting.

Set the H_OVP setting to an
appropriate value.
The setting is changed using the
variable resistor on the front of the
charge/discharge power supply unit.

Check that there is no problem in the
AC line that you are using.

Contact your Kikusui distributor or agent.

Check the TP-BUS connection.

To continue the test, clear the OAH check
box on the Protections | 
Software Protections
page in the test conditions.

Check the end conditions and nominal
capacity setting.

To perform a test at a temperature
exceeding 100 °C, remove the
thermistor and clear the OTP check box
on the Protections |
Software Protections page in the test
conditions.

Check the thermistor connection.
If you are not using the temperature
measurement function, clear the
OTP check box in the Protections |
Software Protections page in the test
conditions.
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Fig. A-4

  

S_OCP

#8008

S_UVP

#8004

S_OVP

#8004

Conn

#8001

Alarm
Code

Cause Corrective Action

A large current flowed as compared
with the specified current.
This normally does not occur.

The software undervoltage protection
of the load was activated.

The software overvoltage protection of
the load was activated.

The connection check function
detected a problem in the connection
of the current wire or sensing wire.

An abnormal current flowed due to
some load condition (when using a
constant current source).

A current greater than the setting
flowed due to a problem in the
charge/discharge power supply unit.

The load voltage dropped below the
S_UVP setting.

The DUT (battery) voltage exceeded
the S_OVP setting.

A problem exists such as an improper
connection in the output cable (current 
wire or sensing wire.)

The output cable (current wire or sensing 
wire) is not connected.
The test cannot be executed.

Check the load conditions.

Contact your Kikusui distributor or agent.

Correct the problem in the DUT
(battery).
If a resistor is used as a load, check
that the voltage drop during discharge
does not fall below the UVP setting.

Set the S_UVP setting to an
appropriate value.
If you are not using the S_UVP, clear
the UVP check box on the
Software Protections page.

Correct the problem in the DUT
(battery).
If a resistor is used as a load, check
that the voltage drop during charge
does not exceed the OVP setting.

Set the S_OVP setting to an
appropriate value.
If you are not using the S_OVP, clear
the OVP check box on the
Software Protections page.

See section A.3, "Operation Examples
When Connections Are Improper"

Clear the Enable DUT Connection
Check check box on the Module page in
the test conditions.
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A.3 Operation Examples When Connections 
Are Improper

 

A.3.1 If the Connection between the Frame and Impedance
Measurement Unit Is Not Correct

 

Operation examples are given below when the connection between the unit frame
and the impedance measurement unit is not correct. If you connect a frame with a
different number, unintended impedance measurement is made on the DUT. It is
especially difficult to detect an incorrect connection when performing numerous test
on DUT with matching characteristics. Use extra caution when configuring the test
system.

 

Table A-6 Incorrect Connection through the DUT Connector (UTP Cable)

Table A-7 Incorrect Connection through the CONT Connector (Modular Cable)

 

No. Cause Description

1
A LAN cable was inserted into the 
DUT connector.

There is no electrical danger, because the circuit is isolated through a trans-
former on the LAN side. However, because power is supplied on the outside 
(pins 7 and 8), the protection circuit inside the device is tripped if a short circuit 
occurs.

2
A CONT connector modular cable 
was inserted into the DUT connector.

There is no danger, but normal measurement is not possible.

3

Different frame numbers were con-
nected in the connection of the DUT 
connector. The CONT connector was 
connected correctly.

Impedance is measured on unintended DUTs (channels).
Because the scanner in the frame does not function, measurement is made with 
the load open (infinity).

4

Different frame numbers were con-
nected in the connection of the DUT 
connector. Likewise, different num-
bers were connected on the CONT 
connector.

Impedance is measured on an unintended DUT (channel).
The scanner in the frame functions. However, measurement is made with the 
load open (infinity) when the corresponding DUT (channel) is charging or dis-
charging. When the corresponding DUT is resting or stopped, the impedance of 
the DUT is measured.

No. Cause Description

1
A telephone line was inserted into 
the CONT connector.

This act is dangerous, because high voltage is supplied to the telephone wire at 
all times.
This may damage the internal protection circuit.

2

Different frame numbers were con-
nected in the connection of the 
CONT connector. The DUT connec-
tor was connected correctly.

Impedance is measured on an unintended DUT (channel).
Because the scanner in the frame does not function, measurement is made with 
the load open (infinity).

3

Different frame numbers were con-
nected in the connection of the 
CONT connector. Likewise, different 
numbers were connected on the DUT 
connector.

Impedance is measured on an unintended DUT (channel).
The scanner in the frame functions. However, measurement is made with the 
load open (infinity) when the corresponding DUT (channel) is charging or dis-
charging. When the corresponding DUT is resting or stopped, the impedance of 
the DUT is measured.
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A.3.2 When the Test Is Executed with Improperly Connected
Output Cables

 

Operation examples are given below when tests are executed with improperly con-
nected output cables. Extremely dangerous conditions may result depending on the
cutoff condition settings such as OVP, UVP, and time. Use extreme caution when
making connections to the DUT.

Hardware OVP and UVP functions are very effective when the DUT is connected
improperly. Be sure to set these functions when configuring the system.

 Symbols used in the table 

▲

 

: Possibility of overcharge

 

▼

 

: Possibility of overdischarge

 

◆

 

: Other dangers
: No danger to the DUT

 

Table A-8 When the connection check function is enabled (abnormalities can be 
detected using the connection function)

 

No.
Test

Mode
Current

Wire
Sensing

Wire
Battery 
Voltage

H_OVP
Setting

H_UVP
Setting

Cutoff
Voltage

If the Test Is Continued Ignoring
the Connection Check Function

Danger
Level

Stop or Cutoff
Condition

1 Charge Reverse Correct ---- ---- ---- ----

CV or maximum voltage is never 
reached, because the DUT is actually 
discharged. As a result, the voltage drops 
even though the DUT is charged.

 

▼

 

UVP
Charge time

-

 

Δ

 

V

2
Dis-

charge
Reverse Correct ---- ---- ---- ----

Cutoff voltage is never reached, because 
the DUT is actually charged. As a result, 
the voltage increases even though the 
DUT is discharged.

 

▲

 

OVP
Discharge time

3 Charge Correct Reverse
1.2 V or 
greater

---- ---- ---- Test execution not possible due to UVP. Warning

4 Charge Correct Reverse ---- ----
0.0 V or 
greater

---- Test execution not possible due to UVP. Warning

5 Charge Correct Reverse
0.0 V to 
1.2 V

----
Negative bat-
tery voltage 
or greater

----

Test execution not possible, because the 
detected voltage (reverse polarity of the 
battery voltage) fall below the UVP set-
ting

Warning

6 Charge Correct Reverse
0.0 V to 
1.2 V

----
Negative bat-
tery voltage 

or less
----

After the test (charge) is started, CV or 
maximum voltage is never reached, 
because the voltage drops even though 
the DUT is charged.

 

▲

 

UVP
Charge time

-

 

Δ

 

V

7 Charge Correct Reverse
0.0 V to 
1.2 V

---- Min ----

8
Dis-

charge
Correct Reverse

1.2 V or 
greater

---- ---- ---- Test execution not possible due to UVP. Warning

9
Dis-

charge
Correct Reverse ---- ----

0.0 V or 
greater

---- Test execution not possible due to UVP. Warning

10
Dis-

charge
Correct Reverse

0.0 V to 
1.2 V

----
Negative bat-
tery voltage 
or greater

----

Test execution not possible, because the 
detected voltage (reverse polarity of the 
battery voltage) fall below the UVP set-
ting.

Warning

11
Dis-

charge
Correct Reverse

0.0 V to 
1.2 V

---- ----
0.0 V or 
greater

Discharge ends immediately, because 
the detected voltage is below the cutoff 
voltage.

Cutoff voltage

12
Dis-

charge
Correct Reverse

0.0 V to 
1.2 V

---- ----
0.0 V or 
greater

Discharge ends immediately, because 
the detected voltage is below the cutoff 
voltage.

Cutoff voltage
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13
Dis-

charge
Correct Reverse

0.0 V to 
1.2 V

----
Negative bat-
tery voltage 

or less

Negative bat-
tery voltage 

or less

Cutoff voltage is never reached, because 
the voltage increases even though the 
DUT is discharged.

 

▼

 

Discharge time

14
Dis-

charge
Correct Reverse

0.0 V to 
1.2 V

---- Min.
Negative bat-
tery voltage 

or less

Cutoff voltage is never reached, because 
the voltage increases even though the 
DUT is discharged.

 

▼

 

Discharge time

15 Charge *1 Correct ---- ---- ----
CV or maximum voltage is never 
reached, because no current flows 
through the DUT.

Charge time

16
Dis-

charge
*1 Correct ---- ---- ----

Cutoff voltage is never reached, because 
no current flows through the DUT.

Discharge time

17 Charge Correct *1 ----
0.0 V or 

less
---- ----

The voltage of the DUT cannot be mea-
sured (0 V is displayed), because the 
sensing line is shorted. Test execution 
not possible due to OVP.

Warning

18 Charge Correct *1 ---- ----
0.0 V or 
greater

----

The voltage of the DUT cannot be mea-
sured (0 V is displayed), because the 
sensing line is shorted. Test execution 
not possible due to UVP.

Warning

19 Charge Correct *1 ----
0.0 V or 
greater

0.0 V or less ----
Continues to charge until the charge 
time elapses or until OAH is activated.

 

▲

 

Charge time
OAH

20
Dis-

charge
Correct *1 ----

0.0 V or 
less

---- ----

The voltage of the DUT cannot be mea-
sured (0 V is displayed), because the 
sensing wire is shorted. Test execution 
not possible due to OVP.

Warning

21
Dis-

charge
Correct *1 ---- ----

0.0 V or 
greater

----

The voltage of the DUT cannot be mea-
sured (0 V is displayed), because the 
sensing wire is shorted. Test execution 
not possible due to UVP.

Warning

22
Dis-

charge
Correct *1 ----

0.0 V or 
greater

0.0 V or less 0.0 V or less
Continues to discharge until the discharge 
time elapses or until OAH is activated.

 

▼

 

Discharge time
OAH

23
Dis-

charge
Correct *1 ---- ---- ----

0.0 V or 
greater

Discharge ends immediately, because 
the detected voltage is below the cutoff 
voltage.

Cutoff voltage

24 Charge Open Correct ---- ---- ---- ----
Stops with an alarm on the CD/B. 
Extremely dangerous if the current wire 
is in contact with a metal part around it.

 

◆

 

CD/B
(CD board

malfunction)

25
Dis-

charge
Open Correct ---- ---- ---- ----

Stops with an alarm on the CD/B. 
Extremely dangerous if the power line is 
in contact with a metal part around it.

 

◆

 

CD/B
(CD board

malfunction)

26 Charge Correct Open ---- Max. Min.
Measured 
voltage or 

less

The battery voltage cannot be measured, 
and an abnormal value is returned. 
Charge ends immediately or after the It 
time elapses.

Max. voltage
It time

27 Charge Correct Open ---- Max. Min.
Measured 
voltage or 

greater

CV or maximum voltage is never 
reached, because the battery voltage 
cannot be measured.

 

▲

 

Charge time

28
Dis-

charge
Correct Open ---- Max. Min.

Measured 
voltage or 

greater

Discharge ends immediately, because 
the detected voltage is below the cutoff 
voltage.

Cutoff voltage

29
Dis-

charge
Correct Open ---- Max. Min.

Measured 
voltage or 

less

Cutoff voltage is never reached, because 
the battery voltage cannot be measured.

 

▼

 

Discharge time

30 Charge Open Open ---- ---- ---- ---- Stops immediately with an alarm.
Warning

CD/B

31
Dis-

charge
Open Open ---- ---- ---- ---- Stops immediately with an alarm.

Warning
CD/B

 *1  The wire is shorted at the - (or +) terminal of the DUT.
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Table A-9 When the connection check function is disabled (abnormalities cannot be 
detected using the connection function)

 

No.
Test

Mode
Current

Wire
Sensing

Wire
Battery 
Voltage

H_OVP
Setting

H_UVP
Setting

Cutoff
Voltage

If the Test Is Continued Ignoring
the Connection Check Function

Danger
Level

Stop or Cutoff
Condition

1 Charge Reverse Reverse
1.2 V or 
greater

--- --- --- Test execution not possible due to UVP. Warning

2 Charge Reverse Reverse --- ---
0.0 V or 
greater

--- Test execution not possible due to UVP. Warning

3 Charge Reverse Reverse
0.0 V to 
1.2 V

---
Negative bat-
tery voltage 
or greater

---

Test execution not possible, because the 
detected voltage (reverse polarity of the 
battery voltage) fall below the UVP set-
ting.

Warning

4 Charge Reverse Reverse --- ---
Negative bat-
tery voltage 

or less
---

The battery is actually discharged, and 
the maximum voltage is never reached. 
There is a danger of overdischarge.

 ▼ Charge time
OAH

5 Charge Reverse Reverse --- --- Min. ---
The battery is actually discharged, and 
the maximum voltage is never reached. 
There is a danger of overdischarge.

 

▼

 

Charge time
OAH

6
Dis-

charge
Reverse Reverse

1.2 V or 
greater

--- --- --- Test execution not possible due to UVP. Warning

7
Dis-

charge
Reverse Reverse --- ---

0.0 V or 
greater

--- Test execution not possible due to UVP. Warning

8
Dis-

charge
Reverse Reverse

0.0 V to 
1.2 V

---
Negative bat-
tery voltage 
or greater

---

Test execution not possible, because the 
detected voltage (reverse polarity of the 
battery voltage) fall below the UVP set-
ting.

Warning

9
Dis-

charge
Reverse Reverse --- --- ---

0.0 V or 
greater

Discharge ends immediately, because 
the detected voltage is below the cutoff 
voltage.

Cutoff voltage

10
Dis-

charge
Reverse Reverse --- ---

Negative bat-
tery voltage 

or less

Negative bat-
tery voltage 

or less

The battery is actually charged and the 
detected voltage increases. There is a 
danger of overcharge.

 

▲

 

Discharge time
Cutoff voltage

OAH

11
Dis-

charge
Reverse Reverse --- --- Min.

Negative bat-
tery voltage 

or less

The battery is actually charged, and the 
cutoff voltage is never reached. There is 
a danger of overcharge.

 

▲

 

Discharge time
Cutoff voltage

OAH

12 Charge

The current wire 
and sensing wire 
are connected 
properly, but the 
end is open (no 
DUT).

--- --- --- --- Stops immediately with an alarm.
OVP
UVP
CD/B

13
Dis-

charge

The current wire 
and sensing wire 
are connected 
properly, but the 
end is open (no 
DUT).

--- --- --- --- Stops immediately with an alarm.
OVP
UVP
CD/B

14 Charge
Connected in par-
allel with other 
channels.

--- --- --- ---

A combined current flows while the 
PFX is operating in constant current 
(CC) mode. Operation is not guaranteed 
after moving to constant voltage (CV) 
mode.

 

▲

 

Charge time
It time

15
Dis-

charge

Connected in par-
allel with other 
channels.

--- --- --- ---
A combined current flows through the 
battery. Abnormality cannot be detected. 
There is a danger of overdischarge.

 

▼

 

Discharge time
Cutoff voltage
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A.4 Folders and Files

 

This section describes the folders and files that are created by the BPChecker2000.

Fig. A-5 shows the folders and files that are created when the test is executed under
the following conditions.

 

Fig. A-5

 

Control Unit
Using 1 system
(Instrument ID: 1)

Charge/discharge power supply unit
2 channels
(Node numbers: 001 and 002)

Group folder
bpc2000(cccv)
Location: Desktop

Test conditions
cccv
3 cycles of execution

Desktop

 bpc2000(cccv)

  cccv.BPCT

  Desktop.INI

  cccv

   [CH_1_001]

    [CH_1_001]_00001_bpc2000(cccv)_cccv.BPCG

    [CH_1_001]_00002_bpc2000(cccv)_cccv.BPCG

    [CH_1_001]_00003_bpc2000(cccv)_cccv.BPCG

    [CH_1_001]_LIFE_C_bpc2000(cccv)_cccv.BPCL

    [CH_1_001]_LIFE_D_bpc2000(cccv)_cccv.BPCL

   [CH_1_002]

    [CH_1_002]_00001_bpc2000(cccv)_cccv.BPCG

    [CH_1_002]_00002_bpc2000(cccv)_cccv.BPCG

    [CH_1_002]_00003_bpc2000(cccv)_cccv.BPCG

    [CH_1_002]_LIFE_C_bpc2000(cccv)_cccv.BPCL

    [CH_1_002]_LIFE_D_bpc2000(cccv)_cccv.BPCL

Group folder

Icon indicating that the BPC2000 system identifies the folder

Test conditions file

File used to change the group folder icon

Test conditions folder (same name as the test conditions)

Channel 1 folder (CH_instrument ID_node number)

Channel 2 folder (CH_instrument ID_node number)

C/D graph cycle 1 data

C/D graph cycle 2 data

C/D graph cycle 3 data

Life graph charge data

Life graph discharge data

[CH_instrument ID_node number]_LIFE_C/D_group folder name_test conditions name.BPCL

[CH_instrument ID_node number]_cycle number_group folder name_test conditions name.BPCG
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After the test is finished, let’s assume that Backup the folder is selected for both
channels 1 and 2 in the data backup dialog box and that the test data contents are
deleted.

We assume that the folder suffix and memo boxes of the data backup dialog box are
entered as follows.

The channel folder is renamed as shown in Fig. A-6, and a file named
BACKUP.TXT is created in the channel folder. This file contains the text “backup
data” that was entered in the memo box.  

Fig. A-6

 

Folder suffix {30 October 2002, 17'07}

Memo box (both CH1 and CH2) backup data

Desktop

 bpc2000(cccv)

  cccv.BPCT

  Desktop.INI

  cccv

   [CH_1_001]{30 October 2002, 17'07}

    [CH_1_001]_00001_bpc2000(cccv)_cccv.BPCG

    [CH_1_001]_00002_bpc2000(cccv)_cccv.BPCG

    [CH_1_001]_00003_bpc2000(cccv)_cccv.BPCG

    [CH_1_001]_LIFE_C_bpc2000(cccv)_cccv.BPCL

    [CH_1_001]_LIFE_D_bpc2000(cccv)_cccv.BPCL

    BACKUP.TXT

   [CH_1_002]{30 October 2002, 17'07}

    [CH_1_002]_00001_bpc2000(cccv)_cccv.BPCG

    [CH_1_002]_00002_bpc2000(cccv)_cccv.BPCG

    [CH_1_002]_00003_bpc2000(cccv)_cccv.BPCG

    [CH_1_002]_LIFE_C_bpc2000(cccv)_cccv.BPCL

    [CH_1_002]_LIFE_D_bpc2000(cccv)_cccv.BPCL

    BACKUP.TXT

Group folder

Icon indicating that the BPC2000 system identifies the folder

Test conditions file

File used to change the group folder icon

Test conditions folder (same name as the test conditions)

Folder suffix added to the channel 1 folder name

Folder suffix added to the channel 2 folder name

File containing the text that was entered in the memo box

File containing the text that was entered in the memo box

C/D graph cycle 1 data

C/D graph cycle 2 data

C/D graph cycle 3 data

Life graph charge data

Life graph discharge data

[CH_instrument ID_node number]_LIFE_C/D_group folder name_test conditions name.BPCL

[CH_instrument ID_node number]_cycle number_group folder name_test conditions name.BPCG
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Other files that are created

 

• Sequence information file (.SI extension)

If the 

 

Use Common Sequence Info

 

 checkbox is selected on the sequence page of
the Test Conditions Editor, a sequence information file with .SI extension is created
in the group folder.

• Test data file in text format (.TXT or .CSV extension, etc.)

If 

 

Generate Text Files

 

 is selected in the 

 

Options

 

 menu of the Test Executive, files
with the same name as the files with .BPCG and .BPCL extensions in each channel
folder are created in the same folders with different extensions (TXT, CSV, etc.).

• Graph files (.BPCO extension)

If you save graphs on the Graph Viewer, graph files with .BPCO extension are cre-
ated.

• Graph data file in text format (.TXT extension)

If you save graphs to text files on the Graph Viewer, graph data files with .TXT
extension are created.
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A.5 Range of Test Condition Settings

 

Below are lists of setting ranges of test condition items specified using the Test Con-
dition Editor.

 

Battery Info

Protections

Recording Method

Impedance Measurement

Life Judgement

 

Item PFX2011 PFX2021

 

Nominal Voltage [V] 0.0000 to 5.0000 0.000 to 20.000

Nominal Capacity [mAh] 0.1 to 110000.0

Volume [ml] 0.01 to 99999.99

Weight [g] 0.01 to 99999.99

 

Item PFX2011 PFX2021

 

Software OVP [V] 0.0000 to 5.1000 0.000 to 21.000

Software UVP [V] -2.1000 to 5.0000 -2.100 to 19.000

OAH [%] 100 to 1000

OTP [

 

°

 

C] -40.0 to100.0

 

Item PFX2011 PFX2021

 

Delta Time [s] 1 to 50000

Auto Delta Time Max Data 
Count

1000 to 5000

Delta Voltage [V] 0.0001 to 0.9999 0.000 to 1.000

Delta Current [A] 0.0001 to 0.9999 0.000 to 1.000

 

Item PFX2011 PFX2021

 

Frequency [Hz] 1000

Range [

 

Ω

 

] 0.1 / 1 / 10 / Auto

 

Item PFX2011 PFX2021

 

Min Capacity Ratio 
[%]

Discharge 0.0 to 100.0

Max Impedance 
[m

 

Ω

 

]

Charge 0 to 20000000

Discharge 0 to 20000000

Max NG Count 1 to 100
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Seq Sheets

 

Charge

 

* The values inside parentheses are setting range for the low range.

 

Mode Item PFX2011 PFX2021

 
CC

Charge Time [h:min] 9999h 59min

Rest Time [h:min] 9999h 59min

Setting Current [A]
0.0000 to 5.0000

(0.00000 to 0.50000)
0.000 to 10.000

Cutoff condi-
tions

Max Voltage [V] 0.0000 to 5.0000 0.000 to 20.000

-dV [V] 0.0010 to 1.0000 0.001 to 1.000

-dV Mask Time 
[min]

1 to 60

Max Temp [

 

°C] -40.0 to 100.0

dT/dt [°C/min] 0.5 to 10.0

CC-CV

Charge Time [h:min] 9999h 59min

Rest Time [h:min] 9999h 59min

Setting
Current [A]

0.0000 to 5.0000
(0.00000 to 0.50000)

0.000 to 10.000

CV Voltage [V] 0.0000 to 5.0000 0.000 to 20.000

Cutoff condi-
tions

CV Time [h:min] 9999h 59min

It Current [A]
0.0000 to 5.0000

(0.00000 to 0.50000)
0.000 to 10.000

It Time [h:min] 9999h 59min

Max Temp [°C] -40.0 to 100.0

Pulse

Charge Time [h:min] 9999h 59min

Rest Time [h:min] 9999h 59min

CC Period

Max Voltage [V] 0.0000 to 5.0000 0.000 to 20.000

Current [A]
0.0000 to 5.0000

(0.00000 to 0.50000)
0.000 to 10.000

CC-Pulse 
Period

Max Voltage [V] 0.0000 to 5.0000 0.000 to 20.000

Current [A]
0.0000 to 5.0000

(0.00000 to 0.50000)
0.000 to 10.000

Time [ms] 0.50 to 65000.00

PWM Period

Max Time [h:min] 9999h 59min

Min Voltage [V] 0.0000 to 5.0000 0.000 to 20.000

Max Voltage [V] 0.0000 to 5.0000 0.000 to 20.000

Current [A]
0.0000 to 5.0000

(0.00000 to 0.50000)
0.000 to 10.000

Time [ms] 0.50 to 65000.00

It Time [s] 2 to 6000
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Discharge

* The values inside parentheses are setting range for the low range.

Temperature chamber

Mode Item PFX2011 PFX2021

CC

Discharge Time [h:min] 9999h 59min

Rest Time [h:min] 9999h 59min

Setting Current [A]
0.0000 to 5.0000

(0.00000 to 0.50000)
0.000 to 10.000

Cutoff condi-
tion

Cutoff Voltage [V] -0.5000 to 5.0000 -2.000 to 20.000

Measurement
Capacity Voltage 
[V]

-0.5000 to 5.0000 -2.000 to 20.000

CP

Discharge Time [h:min] 9999h 59min

Rest Time [h:min] 9999h 59min

Setting

Wattage [W]
0.01 to 25.00

(0.001 to 2.500)
0.02 to 200.00

Limit Current [A]
0.0000 to 5.0000

(0.00000 to 0.50000)
0.000 to 10.000

Cutoff condi-
tion

Cutoff Voltage [V] -0.5000 to 5.0000 -2.000 to 20.000

Measurement
Capacity Voltage 
[V]

-0.5000 to 5.0000 -2.000 to 20.000

CC/CP 
Pulse

Discharge Time [h:min] 9999h 59min

Rest Time [h:min] 9999h 59min

Setting

Num Of Pulse 8 20

Current [A]
0.0000 to 5.0000

(0.00000 to 0.50000)
0.000 to 10.000

Power [W] – 0.02 to 200.00

Time [ms] 0.50 to 65000.00

Cutoff condi-
tion

Cutoff Voltage [V] -0.5000 to 5.0000 -2.000 to 20.000

Measurement

Capacity Voltage 
[V]

-0.5000 to 5.0000 -2.000 to 20.000

Number of pulse 
voltage points

2

Item PFX2011 PFX2021

Temperature [°C] -273.0 to 200.0

Humidity [%] 0.0 to 100.0 or -1

Setting Timeout [min] 1 to 1000

Wait Time [min] 1 to 1000
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A.6 A List of Menus

Test Condition Editor

Test Executive

File

New Creates a new test condition file. This is the same condition as when the 
Test Condition Editor is started.

Open Loads an existing test conditions file.

Save Saves the test conditions file.

Save As Saves the test conditions file to a new name.

Exit Exits the Test Conditions Editor.

Edit

Copy Copies the selected range to the clipboard.

Paste Pastes the contents of the clipboard.

Copy Sheet From Copies the contents of another sequence sheet to the current sheet.

Copy Sheet To Copies the contents of the current sheet to another sheet.

Tools

Run Test Executive Starts the Test Executive.

Options Opens the Options dialog box.

Help

BPChecker2000 TEST CONDI-
TION EDITOR Help Index

Shows the help file.

About BPChecker2000 Displays version information of the product.

File

Exit Exits the Test Executive.

View

Controller Switches the Controller/Group Pane to Controller View Mode.

Group Switches the Controller/Group Pane to Group View Mode.

Channel Test Condition Switches the Graph Result Pane to test conditions display.

Charge Graph Switches the Graph Result Pane to charge graph display.

Discharge Graph Switches the Graph Result Pane to discharge graph display.

Charge Result Switches the Graph Result Pane to charge result display.

Discharge Result Switches the Graph Result Pane to discharge result display.

Toolbar Standard Shows or hides the standard toolbar.

Execution Shows or hides the execution toolbar.

Channel Shows or hides the channel toolbar.

Refresh Refreshes the screen.
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Test

Bind/Unbind Channels Binds or unbinds channels from groups.

Start Assigns test conditions and starts the tests.

Stop Stops the tests.

Empty Clears existing test data.

Reset Alarm Resets alarms.

Emergency Stop Stops the charge/discharge operation on all channels immediately.

Controller

Properties Shows controller properties.

Group

Launch Group Administrator Starts the Group Administrator.

Properties Shows group properties.

Channel

Recognise Makes controller recognize channels.

Plug Moves the identified channels to monitor loop so that tests can be executed.

Unplug Removes channels from the monitor loop.

Reset Alarm Resets alarms.

Edit Test Conditions Starts the Test Condition Editor and opens the assigned test conditions file.

View Folder Displays the folder containing the test data files of the channel.

Enter Cycle Number Sets the cycle number of the channel whose cycle has been completed.

Increment Cycle Number +1 Increments the cycle number of the channel whose cycle has been com-
pleted.

Decrement Cycle Number -1 Decrements the cycle number of the channel whose cycle has been com-
pleted.

Toggle End Mark Terminates the test of the channel in the stopped status. Or, removes the 
end mark from the channel that has already finished the test.

Properties Shows channel properties, sets hardware protection functions, and sets the 
axes of the realtime graph.

Tools

Launch Test Condition Editor Starts the Test Conditions Editor.

Options Sets the graph properties on the Graph List Pane, sets the items shown on 
the Channel List Pane, sets how warnings are displayed, and sets the 
behavior when an alarm occurs when performing tests in synchronization 
with temperature chambers.

Hardware Configuration Starts the Hardware Configuration Wizard in read-only mode.

Help

BPChecker2000 TEST EXECU-
TIVE Help Index

Shows the help file.

About BPChecker2000 Displays version information of the product.
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Graph Viewer

File

Select Project Select the project.

New C/D Graph Opens charge/discharge characteristics graphs.

Life Graph Opens cycle life characteristics graphs.

Open Opens graphs that have been save previously.

Close Closes the graph.

Save Saves the graph.

Save As Saves the graph to another name.

Save Text Saves the graph to a text file (tab-separated).

Show Graph Opens a new charge/discharge characteristics graph or cycle life character-
istics graph.

Print Prints the graph.

Print Preview Shows a print preview of the graph.

Printer Setup Sets the printer type.

Colour Printing Turns ON/OFF color printing.

Exit Exits the Graph Viewer.

Edit

Copy Graph Copies the graph to the clipboard.

Copy Data Copies condition, result, and analysis data to the clipboard.

View

Graph Charge* 1 Displays charge data on charge/discharge characteristics graph.

Discharge* 1 Displays discharge data on charge/discharge characteristics graph.

Charge/Discharge* 1 Displays charge data and discharge data on charge/discharge characteristics 
graph.

Capacity* 2 Displays capacity data on cycle life characteristics graph.

Impedance* 2 Displays impedance data on cycle life characteristics graph.

Capacity/Imped-

ance* 2
Displays capacity data and impedance data on cycle life characteristics 
graph.

X Axis Time* 1 Displays the X axis of the charge/discharge characteristics graph as time.

Capacity* 1 Displays the X axis of the charge/discharge characteristics graph as capacity.

Watthour* 2 Displays the X axis of the charge/discharge characteristics graph as watthour.

Linear* 2 Displays the X axis of the cycle life characteristics graph on a linear scale.

Log*2 Displays the X axis of the cycle life characteristics graph on a logarithmic 
scale.

Y Axis Voltage* 1 Displays the Y axis of the charge/discharge characteristics graph as voltage.

Current* 1 Displays the Y axis of the charge/discharge characteristics graph as current.

Capacity* 1 Displays the Y axis of the charge/discharge characteristics graph as capacity.

Temperature* 1 Displays the Y axis of the charge/discharge characteristics graph as temperature.

Capacity Value* 2 Displays the Y axis of the cycle life characteristics graph as capacity value.

Capacity Ratio* 2 Displays the Y axis of the cycle life characteristics graph as capacity ratio.
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*1When charge/discharge characteristics graph is displayed

*2 When cycle life characteristics graph is displayed

View (continued)

Scale Sets the X axis and Y axis scale.

C/D Pane Switches the tree window display to C/D Pane.

Life Pane Switches the tree window display to Life Pane.

Toolbar Standard Shows or hides the standard toolbar.

C/D Graph Shows or hides the C/D graph toolbar.

Life Graph Shows or hides the Life graph toolbar.

Refresh Refreshes the tree window.

Data

Select Graphs Adds or deletes graphs to the current displayed graph.

Set Analysis Conditions Sets the data used as a reference for computing analysis data and the 
drawing style of the capacity calculation voltage.

Capacity Ratio Reference Cycle* 2 Sets the reference cycle for the capacity ratio on cycle life character-
istics graphs.

Set Comments Sets comments. The comment appears on the graph screen and in 
print.

Set Print Header Sets the print header.

Options

Drawing Style Sets the drawing style of the graphs.

Drawing Unit Sets the unit on the C/D graph.

Save Window Position Starts the program using the window size that was used that last time 
you exited the program.

Window

Cascade Displays multiple windows cascaded.

Tile Displays multiple windows side by side.

Arrange Icons Arranges the minimized windows.

Windows Sets the document window display mode.

Help

BPChecker2000 GRAPH VIEWER 
Help Index

Shows the help file.

About BPChecker2000 Displays version information of the product.
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Index
A

Add Group dialog box  5-4

Adding and Deleting Groups  4-2

Alarm Sync  7-24

alarms, causes of and their correction  A-9

alarms, resetting of  7-12

analysis data, setting of  8-10

Analysis Pane  8-3

Assigning Test Conditions  7-4

assist mode  7-32

auto fine  5-7

Axes page  7-33

B

Basic Edition  P-2

battery information  5-9

BPChecker2000, installation of  1-2

C

C/D graph  8-2, 8-8

Chamber Pane  6-3

channel binding  6-8

Channel Pane  6-2, 7-26

channel properties  7-30

channels, concept of  2-2

charge

CC  5-23
CC-CV  5-21
pulse  5-25

charge conditions  5-19

Charge/Discharge characteristics graph  8-2

color printing and black and white printing  8-15

comments  5-8

comments on graphs, setting of  8-13

common sequence template  5-15

communications requirements  P-4

constant current charge (CC)  5-23

constant current discharge (CC)  5-32

constant current/constant voltage charge (CC-CV)  5-

21

constant current/pulse discharge (CC-Pulse)  5-34

constant power discharge (CP)  5-33

Constant Power Pulse Discharge  5-37

Constraints on changing test conditions during the test

7-14

controller properties  7-29

Controller/Group Pane  6-2, 7-26

controllers, concept of  2-2

CP-Pulse Discharge  5-37

Cycle life characteristics graph  8-2

D

data backup dialog box  7-10

data storage warning dialog box  7-7

Data Table Pane  8-3

Desktop.INI file  4-4

discharge

CC  5-32
CC-Pulse  5-34
CP  5-33

discharge conditions  5-30

Document Window  8-3

Drawing page  7-33

Drawing style  8-9, 8-12

DUTconnection check  5-7

E

emergency stop  7-13

End Mark  7-9

Executing Tests  7-6

existing test data, overwriting of  7-7

F

folders and files that are created  A-16

Form Pane  5-2

Full Edition  P-2

G

Graph Pane  8-3

Graph Result Pane  6-2, 7-28

Graph Viewer  8-2

graphs as text, save of  8-15
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graphs, printing of  8-14

graphs, saving of  8-15

Group Administrator  4-2

group properties  7-30

groups, adding of  4-3

groups, concept of  2-2

groups, creation of  6-7

groups, deleting of  4-4

H

Hardware Configuration Wizard  3-2

I

icon display  7-26

impedance measurement  5-13, 7-25

impedance measurement unit, concept of  2-3

Item Pane  5-2

L

Life graph  8-2, 8-11

life judgement  5-14

M

menus  A-22

module  5-6

Monitor page  7-34

Moving average  5-7

O

operation during improper connection  A-12

Options (Test Executive)  7-33

P

personal computer  P-3

power failures, recovery after  A-1

predischarge  5-30

preference settings (Test Condition Editor)  5-40

print header  8-14

protections  5-10

Protections page  7-31

pulse charge (Pulse)  5-25

R

recording method  5-12

recovery after power failures  A-1

reorganize  3-4

Requirements for performing tests in synchronization

with the temperature chambers  7-21

S

Scale  8-8, 8-12

seq sheets  5-19

sequence  5-15

startup discharge  5-16

status codes  A-7

system requirements  P-3

T

temperature chamber  P-5

temperature chamber synchronization  7-16

temperature chamber synchronization, alarms during

7-24

temperature chambers, assignment to groups  7-20

temperature chambers, concept of  2-3

Test Condition Editor  5-2

test conditions file, creation and save of  5-3

test conditions sheet, copying of  5-39

test conditions, changing during the test  7-14

test data contents, deleting of  7-10

Test Execution Panel  7-2

Test Executive  6-2

tests, restarting of  7-12

tests, starting of  7-4

tests, stopping of  7-8

tests, termination of  7-9

Text generator page  7-35

Tree window  8-3

troubleshooting  6-3

U

USB driver, installation of  1-3

W

Warnings page  7-34
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X

X axis and Y axis  8-8, 8-11
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